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Notice:

PREFACE

Thank you for purchasing your JNS receiver, survey product or accessory (the
«Product»). The materials available in this manual (the «Manual») have been
prepared by Javad Navigation Systems, Inc. («JNS») for owners of JNS
products. This Manual is designed to assist owners with the use of software (the
«Software») to be used with the Product and its use is subject to these terms and
conditions (the «Terms and Conditions»).

Please read these Terms and Conditions carefully.

Terms and Conditions

www.javad.com

PROFESSIONAL USE - JNS Products are designed to be used by a
professional. The user is required to be a professional surveyor or have a good
knowledge of surveying, in order to understand the user and safety instructions
before operating, inspecting or adjusting.

COPYRIGHT - All information contained in this Manual is the intellectual
property of, and copyrighted material of JNS. All rights are reserved. You may
not use, access, copy, store, display, create derivative works of, sell, modify,
publish, distribute, or allow any third party access to, any graphics, content,
information or data in this Manual without NS’ express written consent and
may only use such information for the care and operation of your Product. The
information and data in this Manual are a valuable asset of JNS and are
developed by the expenditure of considerable work, time and money, and are
the result of original selection, coordination and arrangement by JNS.
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Terms and Conditions

TRADEMARKS - JNS® and Javad Navigation Systems™ are trademarks of
JNS. Windows® is a registered trademark of Microsoft Corporation. Product
and company names mentioned herein may be trademarks of their respective
OWners.

DISCLAMER OF WARRANTY - EXCEPT FOR ANY WARRANTIES IN
A WARRANTY CARD ACCOMPANYING THE PRODUCT, THIS
MANUAL, THE PRODUCT, AND ANY ACCOMPANYING SOFTWARE
ARE PROVIDED “AS-IS.” THERE ARE NO OTHER WARRANTIES. JNS
DISCLAIMS ANY IMPLIED WARRANTY OF MERCHANTABILITY OR
FITNESS FOR ANY PARTICULAR USE OR PURPOSE. JNS AND ITS
DISTRIBUTORS SHALL NOT BE LIABLE FOR TECHNICAL OR
EDITORIAL ERRORS OR OMISSIONS CONTAINED HEREIN; NOR FOR
INCIDENTAL OR CONSEQUENTIAL DAMAGES RESULTING FROM
THE FURNISHING, PERFORMANCE OR USE OF THIS MATERIAL, THE
SOFTWARE, OR THE PRODUCT. SUCH DISCLAIMED DAMAGES
INCLUDE BUT ARE NOT LIMITED TO LOSS OF TIME, LOSS OR
DESTRUCTION OF DATA, LOSS OF PROFIT, SAVINGS OR REVENUE,
OR LOSS OF THE PRODUCT’S USE. IN ADDITION JNS IS NOT
RESPONSIBLE OR LIABLE FOR DAMAGES OR COSTS INCURRED IN
CONNECTION WITH OBTAINING SUBSTITUTE PRODUCTS OR
SOFTWARE, CLAIMS BY OTHERS, INCONVENIENCE, OR ANY OTHER
COSTS. IN ANY EVENT, JNS SHALL HAVE NO LIABILITY FOR
DAMAGES OR OTHERWISE TO YOU OR ANY OTHER PERSON OR
ENTITY IN EXCESS OF THE PURCHASE PRICE FOR THE PRODUCT.

LICENSE AGREEMENT - Use of the Software and any other computer
programs or software supplied by JNS or downloaded from a JNS website (the
“Software”) in connection with a JNS Product constitutes acceptance of these
Terms and Conditions in this Manual and an agreement to abide by these Terms
and Conditions. The user is granted a personal, non-exclusive, non-transferable
license to use such Software under the terms stated herein and in any case only
with a single Product or single computer. You may make one (1) backup copy
of the Software. Otherwise, the Software may not be copied or reproduced. You
may not assign or transfer the Software or this license without the express
written consent of JNS. This license is effective until terminated. You may
terminate the license at any time by destroying the Software and Manual. JNS
may terminate the license if you fail to comply with any of the Terms or
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Terms and Conditions

Conditions. You agree to destroy the Software and manual upon termination of
your use of the Product. All ownership, copyright and other intellectual property
rights in and to the Software belong to JNS. If these license terms are not
acceptable, return any unused Software and the Manual.

CONFIDENTIALITY - This Manual, its contents and the Software
(collectively, the “Confidential Information”) are the confidential and
proprietary information of JNS. You agree to treat Confidential Information of
JNS with a degree of care no less stringent that the degree of care you would use
in safeguarding your own most valuable trade secrets. Nothing in this paragraph
shall restrict you from disclosing Confidential Information to your employees as
may be necessary or appropriate to operate or care for the receiver. Such
employees must also keep the Confidential Information confidential. In the
event you become legally compelled to disclose any of the Confidential
Information, you shall give JNS immediate notice so that it may seek a
protective order or other appropriate remedy.

WEBSITE; OTHER STATEMENTS - No statement contained at the JNS
website (or any other website) or in any other advertisements or JNS literature
or made by an employee or independent contractor of JNS modifies these Terms
and Conditions (including the Software License Agreement, Disclaimer of
Warranty and limitation of liability).

SAFETY - Improper use of a INS Product can lead to injury to persons or
property and/or malfunction of the Product. The Product should only be
repaired by authorized JNS warranty service centers. Users should review and
heed the safety warnings in the manual accompanying the Product.

MISCELLANEOUS - The above Terms and Conditions may be amended,
modified, superseded, or canceled, at any time by JNS. The above Terms and
Conditions will be governed by, and construed in accordance with, the laws of
the State of California, without reference to conflict of laws.
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About This Manual

Welcome to the PCView Software Manual!

This manual explains how to install, set up, and use the PCView software. For
best performance of this software, please read all of the instructions carefully.
They were especially designed to help you correctly install and operate this
program. This manual assumes that you are familiar with GPS and also have
some knowledge of working with JNS receivers.

Symbols and Typographic Conventions

This manual uses the following text conventions

Example Description

clock offset This format is used in definitions or when it is necessary to
emphasize that the marked term is technical jargon.

Satellites This format represents titles of dialog windows/boxes,
names of menu options.

Internal This format identifies program interface objects, such as
checkboxes, edit boxes, radio buttons, etc.

Ctrl+V This format is used to specify keys and key combinations.

Temp This format is used to enter various string information (e.g.,

file and directory names) as well as operator commands.

Also, in this manual you will find four levels of special visual cues to
certain types of information.

Tip:  Supplementary information that can help you configure,
maintain, or set up a system.

Notice:  Supplementary information that can have an affect on
system operation, system performance, measurements,
or personal safety.

CAUTION: Notification that an action has the potential to
adversely affect system operation, system
performance, data integrity, or personal health.

xii PCView Software Manual www.javad.com
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DANGER:
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About This Manual

Notification that an action will result in system
damage, loss of data, loss of warranty, or personal
injury.

UNDER NO CIRCUMSTANCES SHOULD THIS ACTION BE
PERFORMED.
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GETTING STARTED

PCView is a windows application for controlling radio navigation receivers
developed and manufactured by the Javad Navigation Systems company.

Before you start using PCView, you should become familiar with its functions
and learn how to install, launch, exit and uninstall the program. This
information is split into the following sections:

Introducing PCView ........ ... . . .. 1-2
Settingup PCView ...... ... ... . . . i 1-3
Getting Connected . ....... ... 1-6

www.javad.com PCView Software Manual 1-1
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Introducing PCView

The most current version of PCView provides the following functions:

* A way to connect a JNS receiver and a computer via serial, parallel, USB or
Ethernet ports (Direct Connection Mode).

* Internet Server feature that provides the ability for Internet Clients to get
access to a JNS receiver from a remote distance. To do this, the user can run
PCView in Internet Server mode on a computer connected to the Internet.

¢ Internet Client feature that provides remote access to a JNS receiver
connected with Internet Server. In this case the user can run his/her PCView
in Internet Client Mode.

* Tracking of the total number and the status of all visible satellites.
* Displaying the receiver’s current position and time in real time.

* Controlling the recording of raw data measurements into the receiver’s
internal memory.

* Downloading collected raw data measurements (log files) from the
receiver’s internal memory onto the computer’s disk drives.

* Recording, in real time, the receiver’s raw data measurements on the
computer’s disk in JNS and RINEX formats. To generate RINEX files, the
executable file jps2rin.exe must be installed on your PC.

* Display, in real time, the graph of the receiver’s current position and the
satellite sky plot.

* Displaying and programming the receiver’s settings (such as Data
Recording Interval, Position Computation Mode, etc.)

* Display of the current receiver options and loading of Option Authorization
Files into the receiver.

* Creating and uploading configuration script files to the receiver.

1-2 PCView Software Manual www.javad.com
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Setting up PCView

System Requirements

Before installing and using PCView, take a moment to run through the
system requirements listed below.

* PC-compatible with Intel® Pentium® 100 MHz or faster

* 5 Mbyte free disk space

* 16 Mbyte RAM or more (32 Mbyte recommended)

* 32-bit operating system such as MS Windows 95/98/Me/NT/2000/XP
* Color monitor with minimum 640x480 screen resolution

* Internet Server/Client applications require your computer has a
connection to the Internet

PCView MS and PCView Lite

PCView exists in two implementations: the full-functionality version called
PCView MS, and the reduced-functionality version called PCView Lite.
Differences between PCView MS and PCView Lite are listed in Table 1-1

Table 1-1. Differences between PCView MS and PCView Lite

Function PCView MS PCView Lite

Remote connection to a receiver via yes no
the Internet

Direct connection to a receiver via yes no
Ethernet port

Record data on a PC’s disk drive in yes no
real time (“Real-Time Data Log-

ging)

Graphical presentation of the yes no

receiver’s current position & the sat-
ellite sky plot

PCView MS may have a limited lifetime as a full-functionality tool. After
the current version of PCView MS expires, its extended functions, listed in
Table 1-1, are automatically disabled so that PCView MS turns into PCView

www.javad.com PCView Software Manual 1-3
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Lite. Table 1-2 on page 1-4 provides a more detailed description of the
different scenarios available.

Table 1-2. PCView MS Authorization Algorithm

If th_e Firmware And the
Version Installed
. Connected Then...
on the Receiver -
Receiver Is...
Is...
2.3 or newer Authorized PCView MS will never expire
and will always work as MS
(full functionality) when con-
nected to this authorized
receiver.
2.3 or newer Not authorized PCView MS will work as Lite
(reduced-functionality).

If the Firmware Version Installed on

the Receiver Is... Then...

2.2p3 or older PCView MS will work as MS
until the expiration date. Once
this date has been reached, the
program changes into Lite
mode.

Notice: PCView Lite will never turn into PCView MS and will never expire.

Installing PCView

There is no special installer for the current version of PCView. This tool is a
ready-to-run executable.

Notice: Below is the procedure for downloading PCView from the JNS
website.

To install PCView on your computer from the JNS website, take the
following steps:

2. Visit the Support section of JNS website (http://www.javad.com/).
Click on the Free Software link on the top of the window. Next, select
the Click here to download pcvu_It.zip to start program downloading.

3. The File Download dialog box will be opened. To continue the
download process, press Save .
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4. In the Save As dialog window, specify the desired destination (disk
drive/folder) for the archive pcvu_It.zip Wait while the archive is
being downloaded onto your system.

5. Create a folder on your local disk drive. It is recommended to use C-\
Program Files\JNS\PCView.

6. Unpack the archive into this folder with WinZip® or another
appropriate software. You will see the following files appear in the
folder:

* Executable file Pcview.exe
* Auxiliary binary file Iptaccess.vxd

Removing PCView

The simplest way to remove PCView from a system is to delete the whole

directory1 that was created when installing PCView and in which
Pcview._exe and all of its components reside. Also, do not forget to
delete the PCView shortcut, if available.

1. Assuming this directory is not used for storing any other (i.e., PCView unrelated) data.

www.javad.com PCView Software Manual 1-5
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Getting Connected

Starting PCView

PCView can be launched, as any other Windows program, for example, with
the Start button.

Notice: After the user first runs PCView, he/she will see the file pcview.ini
appears in the directory from which the executable has been
launched. In this .INI file PCView will store all its settings.
PCView will automatically modify the contents of the .INI file as
the user makes changes through the program’s controls.
Because this file use only plain text (i.e., ASCI|), it can also be
edited with any text editor or word processor. Before changing
the file it is strongly recommended that you make a backup copy
of the original .INI file.

Notice: If the user wants to have more than one copy of PCView, each
one with its own unique settings, the user can keep these copies
in separate directories. Running different copies of PCView from
different directories will allow the operator to maintain unique
setting for each of the copies.

Once PCView is launched, the Connection Parameters window will
appear (Figure 1-1).

7 Connection Parameters

Connection mode:
IV(: Direct " Intemet Client " Interet Server |

~Poit setting

Fot [CoM1 =] Baudrate: [115200 =] T Infrared part
¥ RTS/CTS handshaking
Program sefting

I™ Passvemode [ Manual mode only  Timeout [msf [10000 =
I™ Restore the receiver's orginal baud rale on Disconnect
Intemet ( Clent - Server | seting

Hestrameifiocabost | [ERpat [aomn |
Password: |

I~ Displey datmonserver ¥ Logseverevents [ DS fackup

Cancel

Figure 1-1. Connection Parameters

In this window the user first selects the desired connection mode:

* Direct. This mode is used when it is required to connect a computer and
a JNS receiver directly, i.e., using the computer and receiver serial,
parallel, USB or Ethernet ports and an appropriate cable.
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You can use Ethernet ports to establish direct connection
between a computer and a JNS receiver using direct cable
connection or similar direct connection through the Internet. For
more information about communicating via Ethernet, see
“Establishing an Ethernet Connection” on page 1-12.

* Internet Server. When running PCView in Internet Server mode on a PC

connected to the Internet, the software provides the ability to get remote
Internet access to the JNS receiver (connected to this PC by serial,
parallel, USB or Ethernet direct connection modes), using PCView
Internet Client working on a remote PC. Current Internet Server
implementation allows for access by only one remote PCView Internet
Client at a time.

Internet Client. This mode may be used when it is required to access a
remote receiver that is directly connected with some other PC and the
PCView software is running on that PC in Internet Server mode. Both
computers with PCView Internet Server and Internet Client software up
and running, should be connected to the Internet to get the remote
Client access to Server.

Establishing a Serial Port Connection

To establish a connection between your computer and the receiver using
serial ports, follow these steps:

1.

Connect one of the available receiver’s port (usually A) to a
communication port on the computer using a Receiver-to-Computer
RS-232 serial cable.

Supply power to the receiver and computer, then turn them on.

Run PCView and in the Connection Parameters window select the
following items.

— From the Port list box, select the computer serial port (COM1,
COM2.,...) that you want to use for the connection.

— From the Baud Rate list box, select the desired baud rate.
— Select the RTS/CTS handshaking checkbox.

It is recommended that the user enables RTS/CTS
handshaking as this makes data exchange between the receiver

PCView Software Manual 1-7
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and computer more reliable. Prior to selecting this control, make
sure that:

Notice: RTS/CTS handshaking is supported both at the computer and at
the receiver.

Notice: The cable used allows RTS/CTS handshaking.

4. Press Connect. Figure 1-1 on page 1-6 shows an example of the
Connection Parameters window for this connection type.

Notice: By changing the parameters in the Port settings area of the
Connection Parameters window, the user configures the
communication port of the PC and the desired settings of the
receiver’'s communication port, which will be set up once you
click the Connect button.

The Infrared port checkbox is selected when the user want to use an infra-
red adaptor to establish a connection between a computer and receiver over
an infrared data-link.

Connection via an infrared port will be available only if the following
conditions are met:

* An appropriate external infrared adaptor is connected to the selected
serial port on the computer side.

* Your receiver supports the infrared port hardware-wise.
* The Infrared Port option is enabled in your receiver.

Along with the above listed controls, the user may need to adjust some of
the settings in the Program Settings area. This area includes the following
four controls:

* Passive mode

* Manual mode only

* Timeout

* Restore the receiver’s original baud rate on Disconnect

In Passive mode PCView is not allowed to change any receiver parameters.
Note that in this mode PCView will display in the main window only those
satellites whose elevation angles are larger than the elevation mask specified
by the receiver elevation mask for the given port (see the parameter
Terminal Elevation Mask on page 2-28). Once Passive mode is off,

PCView will automatically force Terminal Elevation Mask to -90°.
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Therefore the user will be able to view in PCView’s main window all of the
satellites that are being tracked. It is important to remember that this setting

(-90%) will be effective as long as the main window remains open. Note
however that the original value of Terminal Elevation Mask will not be
lost in this case; once the main window is closed, PCView will
automatically restore the original mask.

If Manual mode only is on, PCView will perform as an input/output
terminal, which allows the user to send commands to and receive
information from the receiver without performing any connection procedure
with the receiver.

With the Timeout [ms] drop down list box, the user specifies the number of
milliseconds the program will wait before switching to the next baud rate
while establishing connection with the receiver through serial ports.

If the user has selected the Restore the receiver’s original baud rate on
Disconnect checkbox, PCView will determine and save the receiver port’s
original baud rate (i.e., that the receiver port had before running PCView)
and then restore this setting automatically on disconnecting the receiver (by
pressing the Disconnect menu item).

Establishing a Parallel Port Connection

Before connecting the receiver and your PC using parallel ports and the
corresponding cable, make sure the following requirements are met:

1. The computer runs under Windows 95, 98 or ME.
2. The computer’s parallel port has been configured as ECP or ECP+EPP.

3. The Parallel Port option has been enabled in the receiver.

If run on a Windows NT/2000/XP computer, PCView does not allow
connection to the receiver via parallel ports.

To establish a connection between your computer and the receiver using
parallel ports, follow these steps:

1. Connect the receiver’s parallel port (usually marked Parallel) to a
parallel port on the computer using a supplied Receiver-to-Computer
parallel cable.

2. Supply power to the receiver and computer, then turn them on.
3. Run PCView.
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4. From the Port list box, select the computer parallel port (LPT1,
LPT2,...) that you want to use for the connection.

5. Press Connect (Figure 1-2).

2 Connection Parameters

Connection mode:
[ﬁ Direct " Internet Client " Internet Server

- Poit setting

Po: [LPT1 =] Baudieie [Paralel J2 [ i =
I | BB/ andshizki
~Pragram setting:

™ Passivemode [ Manual mode orly

I | st the veceivers el B=us e Eriisosrres
Intermet [ Clisnt - Server | satting

Hostriames|localhost et | 2000
Passmords |

I Disleyideta orserver [ | logservereverts [ (RS oo

Cancel

Figure 1-2. Parallel Port Connection Parameters

For a description of the available Program settings, see “Establishing a
Serial Port Connection” on page 1-7.

Establishing a USB Connection

Before connecting a USB equipped JNS receiver with PC’s USB port, make
sure that you have the USB Port option enabled in the receiver and the JNS
USB driver installed on the computer.

Checking Option

To verify whether or not the USB Port option is enabled, you can use a
direct serial cable connection. Once connected, click Tools, then
Receiver options.

* If enabled, you will see yes in the Current column of the USB Port
option.

* If disabled, you will see no in the Current column of the USB Port
option.
Installing Driver

The driver installation procedure varies slightly depending on the

operating system used. In general, the installation procedure is as
follows:
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1. Visit the the JNS website (http://www.javad.com). Click on the
Free Software link in the Support window. Next, click on the
jns_usb.zip link to start driver downloading.

2. Unpack the archive into a separate, empty folder. You will see the
following files appear in the folder:

* tpsusbio.sys
* tpsusb98.sys
* jnsusbio.inf

3. Connect the receiver to the computer through the supplied USB
cable. Turn the receiver on.

4. Windows will automatically detect the new hardware device.
Follow the on-screen instructions to finish installation process.

After Windows finishes installing the driver, you will be able to connect
the receiver and the computer via USB ports.

Connecting
To establish a connection with the receiver using USB ports, follow

these steps:

1. Insert the USB cable’s 5-pin connector into the USB port of the
receiver. Plug the opposite end of this cable into the USB port on
the computer.

Turn on the computer and receiver.
Start PCView.
From the Port list box, select the computer’s USB port (USB).

From the Rec ID list box, select the receiver’s ID you want to
connect to.

A
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6. Press Connect (Figure 1-3).

|7 Connection Parameters B
Connection mode:
[ﬁ Direct " Internet Client " Internet Server |

Pt setting

Por: [Use =] RecID: [2000PaisRK ] I inieed por

~Program setting:
[# Passivemode = Manualimode onfy Timeout sl | 500 -

[ | Restare the receiver’s original baud rate on Disconnect

Intemet [ Clisnt - Server | satting:

Host niame: localhost TR part | 2000

Password’ |

= Displey dataonsever ¥ Log semvenevents I~ DHE [agkup

Cancel

Figure 1-3. USB Connection Parameters

For a description of the available Program settings, see “Establishing a
Serial Port Connection” on page 1-7.

WARNING: USB connection cannot be established if you run the PC under
Windows 95/NT.

Establishing an Ethernet Connection

There are two Ethernet-based methods used for communication with a JINS
receiver:
1. Communication with a receiver directly connected to a computer

2. Communication with a receiver connected to an existing TCP/IP
Ethernet network

Connecting the Receiver Directly to a PC

This method is used when you have a PC, a JNS receiver and have no
existing Ethernet network, but would like to communicate with the
receiver via Ethernet.

Notice: It can be useful to apply this method for preliminary tests if you
are going to use the receiver later on a real TCP/IP network.

Before establishing the connection, make sure you have the following:

* A PC with an Ethernet card installed and the TCP/IP protocol
configured
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* A JNS receiver with physically installed and enabled by options

Ethernet port
Appropriate cables:
—Ethernet adapter (p/n 14-008032-01).

—An Ethernet cross-over cable (this cable is typically available from
your local computer store or from many online computer stores).

—You should also have an RS-232 cable (p/n 14-008005-02) to
configure IP settings of your receiver.

The following procedure shows you how to connect the receiver
directly to a PC using Ethernet ports.

You should have already installed an Ethernet card and
configured the TCP/IP protocol on your computer. For
definiteness assume that you use a protocol with the following
settings. IP address — 192.168.0.1, Gateway — 192.168.0.3
(actually, since you have only two devices connected directly
and have no connections to another network, you can set the
gateway address all zeros), Subnet mask — 255.255.255.0.

Take these steps to connect the receiver to a PC using the Ethernet
ports:

1.
2.

Connect your computer and receiver with a serial cable.

Run PCView. Select appropriate communication settings for
connection via serial ports and then click Connect.

Go to Configuration » Receiver » Ports » Ethernet.
Specify IP settings for your receiver.

IP Address — set the same value as the computer’s IP address,
except for the last number (it must differ from the computer's IP
address but lies in the range from 0 to 255, for example,
192.168.0.2)

IP Mask - set exactly the same number as you use for the computer

Gateway — set exactly the same number as you use for the
computer

In the Telnet Settings area leave all settings as they are but make
sure that TCP port is set to 8002.
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Remember the value in the Network Password field (if you do not
want to use any password, you may simply clear this field). Click
Apply » OK.

6. Restart the receiver by selecting Tools » Reset receiver.

7. Insert the corresponding end (having seven pins) of the Ethernet
adapter into the ETHR port of the receiver. Connect the other end of
this adapter with the Ethernet crossover cable (either of its ends can
be used). Plug the second end of the crossover cable into the

Receiver Cross-over Cable
Ethernet Adapter

Figure 1-4. Direct Ethernet Connection - Hardware Setup

8. Run PCView. In the Connection Parameters window, specify the
following settings:

¢ Connection mode — Direct
Port — ETHR
TCP port — 8002

Host name — IP address that you have assigned to the receiver in
step 4.

* Password — exactly the same series of characters as you have
specified for the receiver in step 5 or keep it blank if you do not use
a password.
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9. Click Connect (Figure 1-5).

22, Connection Parameters ]
Connection mode:

[ﬁ Direct € Intemet Client € Intsmet Server |

Pt setting

Poi [ETHR | Hostname: [192168.02

TCP part: |a002 Password

~Program setting:
[# Passivemode = Manualmode onfy  Timeout sl |500 -

I | Restore the receiver’s original baud rate on Disconnect

Intemet [ Clisnt - Server | satting:

Hostname |52 105.132.105 TER park | 2000

Password |

¥ Display dataonserver ¥ Log semverevents I~ DHE [agkup

Cancel

Figure 1-5. Ethernet Connection Parameters

After establishing connection, you will see the current connection
type (Ethr) and the receiver's IP address in the bottom left corner of
the PCView's main window (Figure 1-6).

PCView to MAXOR ID:BRKW5YZP4WO. (base)
e Configuration Tools Help

GPS Satellites (6] Geo |%Z | Terget| GLONASS Satelites [2)
% | EL| Az CA|P1| P2 TC| 86|  Lak 55'56193977'N  [Gn[Fn| EL| Az|CA| P1| P2| TC| 55
07 13- 29 45 12 12 63 00 rSOEMATE %0 qi- g om o3 M 62 oo
140 1% B MW N 6 0 23 11 28 M B\ N B 6 00

Vel 0.0805 m/s

20 |67+ | 278 30| 5[ 5| 62100 | | [meaate i,
23 30« 22 41 14 14 53 00+ Rysvet 0119 mes
20 45 2% 47 20 20 5 00+ PpOP 5876
I M B WA R (standslone]

Fieceiver fime; 034051
Fieceiver date: 15.06 2005
Clock. offzet: -0.4230 pom
Osc. offsst: -0.4230 pom
Tracking five: 01:03:01

[Ethr. 197 166.0.2 00.08:43

Figure 1-6. PCView Main Window - Ethernet Connection Established

From this moment on, you may interact with the receiver in a
normal way (i.e., record files into the receiver's memory and onto
the computer's drives, send commands into the receiver, and so on).

Connecting the Receiver to an Existing TCP/IP Ethernet
Network
This method is used when you have an existing local area network
(LAN) consisting of a group of computers and network communication
devices interconnected and a JNS receiver that you want to place on this
LAN. This method is also used to connect a JNS receiver directly to the
Internet and access this receiver from a remote PC, connected to the
Internet.
Before establishing the connection, make sure you have each of the
components listed below:
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* An operational TCP/IP LAN or connection to the Internet
* Appropriate cables:
—Ethernet adapter (p/n 14-008032-01).

—A straight-through Ethernet cable (this cable is typically available
from your local computer store or from many online computer
stores).

—You should also have an RS-232 cable (p/n 14-008005-02) to
configure IP settings of your receiver.

* A JNS receiver with physically installed and enabled by options
Ethernet port. To verify whether or not the Ethernet options are
enabled, use the Option Manager window of PCView (click Tools,
then Receiver options). The value of the Ethernet Port option in
the Current column must be set to yes. TCP Connections must be
in the range from 1 to 5. FTP Connections must be set to 1 only if
you are going to download receiver files via FTP. For more
information about receiver options including Ethernet-related
options, see Table 2-7 on page 2-80.

The following procedure shows you how to attach the receiver to an
existing network.

Notice: It is very important to work closely with your system
administrator to make the connection succeed. The system
administrator should provide a unique IP address, Subnet mask,
and Default gateway for the receiver. Also, make sure the system
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administrator realizes that each JNS receiver on the network
must have a static IP address, whether or not a Dynamic Host
Configuration Protocol (DHCP) server is used on the network.

1. Connect your computer and the receiver with a serial cable.

2. Run PCView. Select appropriate communication settings for the

connection via serial port and then click Connect.
3. Go to Configuration » Receiver » Ports » Ethernet.
. Specity IP settings for your receiver:
* IP Address
* [P Mask

* Gateway
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If in doubt about which IP settings are safe to
use, consult your system administrator.

5. Configure Telnet Settings and Network Password. You may use

the following settings:

TCP port — 8002 (default value). This is the port on which the
receiver listens for telnet-like connections. The receiver allows up
to five simultaneous telnet-like connections.

Timeout — 600 (default value). This parameter sets the amount of
time in seconds the receiver allows an inactive connection to remain
open. After this time, the receiver terminates the unused connection.

Network Password — an arbitrary sequence of characters (if you do
not want to use any password, you may simply leave this field
blank).

Configure FTP Settings (optional). You may use the following
settings:
TCP port — 21 (default value). This is the port on which the

receiver listens for FTP connection. The receiver allows only one
FTP connection at a time.

Timeout — 600 (default value). This parameter sets the length of
time in seconds the receiver allows an inactive connection to remain
open. After this time, the receiver terminates the unused connection.

Click Apply » OK.
Restart the receiver by selecting Tools » Reset receiver.

Insert the Ethernet adapter’s 7-pin connector into the ETHR port of
the receiver. Connect the opposite end of this adapter with the
Ethernet straight-through cable (either of its ends can be used). Plug
the second end of the straight-through cable into the appropriate
Ethernet port on your LAN hub or switch (Figure 1-7 on page 1-
18).
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Straigth-thru Cable

Figure 1-7. Receiver on LAN - Hardware Setup]

At this point, it is a good idea to check that the receiver responds to the ping
command. From the Windows command prompt or Run dialog box, type: ping
[receiver’s IP address]. For example, ping 195.105.138.43. If the receiver
responds, go to step 10. If it does not respond, double-check the LAN
connections and addresses.

9.

10.
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Run PCView. In the Connection Parameters window, specify the
following settings:

Connection mode — Direct
Port — ETHR
TCP port — 8002

Host name — IP address that you have assigned to the receiver in
step 4

Password — exactly the same series of characters as you have
specified for the receiver in step 5 or keep it blank if you do not use
a password.

Click Connect (see Figure 1-4 on page 1-14). After establishing the
connection, you will see the current connection type (Ethr) and the
receiver's [P address in the bottom left corner of the PCView's main
window (see Figure 1-6 on page 1-15). From this moment on, you
may interact with the receiver in a normal way (i.e., record files into
the receiver's memory and onto the computer's drives, send
commands into the receiver, and so on) plus some network abilities
(i.e., transfer files from the receiver over a TCP/IP network using
FTP, connect up to 5 remote telnet-like terminals to the receiver).
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Establishing an Internet Client-Server Connection

Internet Server Mode

When running PCView in Internet Server mode, the software provides
the ability to get access to a JNS receiver connected to the computer
with a direct serial, parallel or USB connection from a remote location.
Remote terminals (PCView clients) can then access this PCView server
via the Internet.

Notice: The current implementation of the Server feature allows for
access by only one remote terminal (PCView client) at a time.

The parameters Port, Baud rate, Infrared port, RTS/CTS
handshaking, Passive mode serve the same purposes as in Direct mode
(see “Establishing a Serial Port Connection” on page 1-7). The other
group of parameters, Internet (Client - Server) settings, are intended
for the user to tune PCView for Internet connection: TCP port,
Password, Display data on server, Log server events, and DNS
lookup.

Special attention should be given to setting TCP port for PCView

servers!. Make sure that the selected TCP port does not coincide with
any one of the reserved port numbers. The default TCP port number is
8000.

The Password edit box is used to protect the PCView server from
unauthorized access. The user can enter in this edit box up to 128
alphanumeric characters.

If the user has selected the Log server events checkbox, there will be
created a text log file (pcview_server . 10g) in PCView's working
directory. This file will contain some information that has been
collected during the communication session between the PCView server
and PCView client. New information will be added to the file after
another client connects to the PCView server.

If the user wants to view the satellite information and the antenna's
current position in the main windows, he/she must select the Display
data on server checkbox. Otherwise no information will be displayed
in the window.

1. According to TCP specifications, TCP port number can be up to 64 K. Although the user can formally
enter a port number N, which is greater or equal to 64 K, the software will implicitly force it to N mod
64 K.
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If the DNS lookup checkbox is selected, the file
pcview_server.log will contain the IP and DNS addresses.
Otherwise this file will include the IP addresses only.

Figure 1-8 shows an example of the Connection Parameters dialog
window in Internet Server mode.

onnection Parameters

1+ Internet Server

1~ Intemet Zlient

Port: ICDHT j Baud rate: |115200 ;I I Infrarec port
[~ RTS/CTS handshaking

i~ Program setting:
¥ Passivamode [ Manual mode only

¥ Restor= orginal Receiver's baud rate on Disconnect

—Internet zetting:

Hist narne:l\t-calhns-l THER part |3L1U[l
Fasswond |

I Uisplapdetacriserver [ELGTseenevents |l

Connect I Cancel I

Figure 1-8. Internet Server Connection Parameters

In this example a four-character password and the default TCP port
number are used.

After the Connect button is pressed, the Main and Server dialog
windows will be displayed (Figure 1-9).

PCView to MAXOR ID:BRKW5YZP4V/0
Configuration Touks Plats Help
PS Satellites (9) Geo |2z | Target] GLONASS Satellites (4)
# [ L] sz[calpipa] To] ss] Lab 55 a2 602838°N  [on[en[ EL] az[cal Pr]pe] TC] Ss]
Lon: 37" 35 396736°E  ['n7 "0y [78- | 22| 62| 54 46| 2|00+

03 3| 202 47| 30|30 2|00+
09 16| 6443 23| 24 2 00| b aghEenm 03 |12 38+ 25548 48| 41| 2 00+
11|24 | 25( 44| 27| 28] 2|00+ | |NeiS el 1705 | 42- 208 47 48 35 2 OO
T4 44| 154 60| 3536 2 00+ | | pmawer D0Sidese |18 10 44+ 312 4849 40 200+
15 45 114 50 37 3 2 00+ ppOp 18340

18 2. 66 44 2828 1 00+ (a5 alere]

2 B2 76 54 M 42 2 00+

B Nel 336142100177 f 00+ Riaceiver time: 12:9221

U 51 2050 39 B 0% Beceiver date: 30,02, 2004
Clack offset: -1.7640 ppm
Ose. offset: -1,7640 ppm
Tracking time: 00:02:51
server 3000 [ I Display data 00:01:34
iew to MAXOR ID: o =10l x|
Chat | W Beep on receive

~|[server started 16:32:50 30.03.2004 <]

s o

Sent 0 [Recv. 0@ [Ewars:0 [Delay: Oms O

Figure 1-9. Internet Server Started
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The Server window allows an operator running PCView Server to
communicate with his/her counterpart who runs the corresponding
PCView Client. In addition, this dialog window displays information
about the server's current status.

Internet Client Mode

The user selects Internet Client mode when it is required to access a
remote receiver that is directly connected with and controlled by a
computer on which PCView Server is being run (the obvious pre-
condition is that both computers must have access to the Internet).

After a connection to the remote receiver is established, the user can
control this receiver exactly in the same manner as if the user's
computer were directly connected to the receiver, specifically: send
commands to the remote receiver, download log files from the receiver's
memory, etc. In order to be able to connect to the remote receiver, the
user first needs to configure his/her computer as a PCView Client
capable of working with the corresponding PCView Server.

The user is required to know the following information about the
PCView Server:

e IP or DNS address
* TCP port number
* password (if necessary).

Figure 1-10. shows an example of the Connection Parameters dialog
window with the following settings:

¢ PCView Server’s IP address: 194.85.135.59
e TCP port number: 8000
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¢ Password is not used

“ Connection Parameters

|’Eumnecllun mode

£ Unect & dnternet _iieni 1 Intemet Server
- Part's setting:
Fatfconz |7 Bediete {15200 7] IS erec et

1= FTSYETE Fantishiaking

i~ Program setting:
[ Passivamode [ 1 enuialimods orfy

™ Restor= original Receiver's baud rate on Disconnect

| Internet setting:

Host name: |1s4 6513559

TCP port: {5000

Password I

™| Digplay dataoresver W Loasenvenevents

¥ DYS lookup

Connact I

Cancel |

Figure 1-10. Internet Client Connection Parameters

After all necessary settings have been entered into this window, press
Connect. You will see PCView open the Main window and the Client
window (Figure 1-11.).

2 PCView to MAXOR ID:BRKWSYZP4VIO at (62.105.138.105):8000
File Configuation Tools Flols Help
GPS Satellites (7) 2z | Taget| GLONASS Satellites (2]
# | EL] ez[calpi]pe] 1] ss  Lak 55°4280730"N  [sn[FEn[ EL[ az[calpi]Pe] 1e] s5]
Lon: 37° 35 34.4472" E
01 [20+] 222[ 48[ 31| 31| 26[00+| |GESEoSR S 05 |02 |61+| 306 45| 45 ) 44| 25 00+
05 | 7+| 22|38 14| 14| 22]00+ 21 |05 |29+ | 316 35| 34| 30| 200+
Vel 0.0330m/s
07 20+ 310 3% 7 7P 2 00+ | BucPas 52539 m
11 |86~ | 210 | 49| 38| 38| 25 00+ | | RMe Vel 0.0530mss
14 |34-| 60 50| 34|34| 25600+ | | ppop: 21738
20 |80+ | 278 | 62| 37| 38| 25| 00+ eredcns
30 | 4| 6038|1413 1] 16
Fieceiver time: 15:11:51
Fleceiver date:31.03.2004
Clack offset, +0.0588 ppm
Dsc. offset: +0.0127 ppm
Tracking time: 00: 2615
[s2105138 1058000 | 002222
_ol =
Chat [ IV Beep on recsive
~|[connected to (s2.105.138.105):8000 18 <
MSG: PC-CDU Version 2.1.13 December 2
5| KN | _’l_I
Sent: 43432 \Ha:v 665160 \Em.s-u \De\ay- 0(0, 2714) ms r

Figure 1-11. Internet Client Started

The Client window allows the operator running PCView Client on one
end to exchange messages with the operator running PCView-Server on
the other end. Messages sent from the client to the server are preceded
by the character ">". Messages sent by the server to the client begin
with the character "<". The last received message is topmost in the list.
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Closing PCView

To disconnect from the receiver, select the Disconnect menu item from the
File menu. Alternatively, you can use the Ctrl+D keys to close the
connection.

Pressing Disconnect will result in

1. Turning off RTS/CTS handshaking.

2. Resetting the receiver control Terminal Elevation Mask to its original
value (only if the Passive mode checkbox has not been deselected).

3. Resetting the baud rate to 115200, if the receiver’s original baud rate
(i.e., that the receiver has before running PCView) exceeded 115200.

4. Restoring the original baud rate, only if the Restore the receiver’s
original baud rate on Disconnect control has been selected.

To quit PCView, select Exit from the File menu. Alternatively, you can
close the program by pressing the Ctrl+X keys.

If the receiver has not been disconnected by the time the program is
terminated, the connection will be automatically broken before PCView is
closed.

It is strongly recommended to close the connection with the
receiver and close PCView prior to switching the receiver off and
disconnecting the cable.
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LEARN PGVIEW IN
DETAIL

This chapter provides procedures for using the various software functions, as
well as describes each menu, dialog, and field found in the software
interface.This information is described in the following sections:

Understanding Elements of the Main Window . ............. 2-2
The Main window’smenu ................c.couvuven.... 2-8
File Manager Window .......... ... .. ... ... .. ... ..... 2-11
Real-Time Logging Window .......................... 2-18
Manual Mode Window . ......... ... .. ... . . ... 2-25
Receiver Configuration Window ....................... 2-27
Events Tab . ... ... .. . 2-58
Advanced Tab . ....... ... . .. i 2-60
Site Configuration Window ........... ... ... ... .... 2-69
Target position Window .. ........... .. .. ... ... 2-70
RFM96 Configuration Window ........................ 2-71
Initialize file system . ........... ... .. ... ... 2-76
Clear NVRAM ... ... . i 2-78
Resetreceiver ....... ... .. .. 2-79
Receiveroptions ......... ..., 2-80
Scatter Plot Window . .......... .. ... .. .. . .. 2-91
Satellites Plot Window . ........... .. ... ... .. ... .. ... 2-93
Position Plot Window . ............. .. .. .. .. . ... 2-95
Plots Configuration .. ......... ... ... i .. 2-97
About PCView Window . ........................ 2-99
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Understanding Elements of the Main Window

After PCView has established a connection between the computer and receiver,
the Main window will be opened (Figure 2-1). This window can be split into
three areas: the Menu bar, the Satellites and Position area, which is the largest
part of the window, and the Status bar.

2. PCView
Menu File Configuration Tools Plots Help
GPS Sateliites (11] Geo |xrz | Taret] GLONASS Satellites (4)
% | EL| Az[calPi]p2] 1] 85]  Lak 55'42504052'N  [Sn[Fn| EL] Az|ca] Pi] Fo] TC] 5]
03 |21+ | 234 | 42| 27| 27| 42 00w | ([ 7 | 07 |02 | 35 | 42| 42| 37225 oiw

Al 2306776 m
06 | 36- 124 48 33 34 291 00+ Vb 00378 més 03 08 72+ B4 47 B3 45 42 00+

. 10 (13- 40 44 24|24 221 00« : 17 05 (13« 310 46| 45 35| 13 00
Satellite 15 BB+ 295 52 44 44 40 0+ | |meucr ooets |24 03 85+ 310 54|54 45 128 00+
= |17 [e5+ 182 B3 44 43 178 00+ | | pPOOP. 1047
183 172 48 31 A1 65 00x [standalone)

21 | 6+ | 194[35[12| 11| 4|00+
22 |46+ 264 49 33 33 143 00+
23 |5+ 108 B0 39 33 128 OO+
26 |13+ 86 42 23| 23| 28 00+
27 | B+ 336 40 18 18 5 16+

Flecaiver fime: 14:21:34
Recsiver date:07.02. 2002
Clock offset. 12589 ppm
Dsc offsst: 26178 pom
Tracking time: 04:51:14

COM1, 115200, HS | 04:51:11
Status -L! 7.

Figure 2-1. Main Window

Menu Bar

The Menu bar extends across the top of the Mairn window and contains five
menu titles through which the user can access the program functions. By
hovering the mouse pointer over a menu title and then clicking the left
mouse button will cause the menu to drop down, displaying a list of menu
items. Position your pointing device on the desired menu item, then click
and release the left mouse button and that function is invoked (Figure 2-2).
Alternatively, you can use the shortcut keys (if available).

File Configuration Tools Plots Help
[Eorirest [l
Disconnect CirkD

Fieal-Time Logging Clik+F %

Manual Mode Cirl+td

Exit Cirix

Figure 2-2. Menu Bar with the File Manager Iltem Highlighted

Satellites and Position Area

The Satellites and Position area comprises two panels, GPS Satellites panel on
the left and GLONASS Satellites on the right, which are separated by the Geo|
XYZ|Target box. The panels display the basic tracking information (parameters)
for the locked satellites. These tracking parameters are described in Table 2-1
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on page 2-3. The Geo|XYZ|Target box represents the antenna’s current position
(if available) and the time-frequency parameters.

Table 2-1. Tracking parameters displayed in the GPS Satellites and
GLONASS Satellites panels

Parameter Description

# GPS SV PRN. If the character “*” is shown next to PRN in the col-
umn, this means that almanac data are unavailable for the corre-
sponding satellite.

Sn GLONASS SV Orbital Slot Number. If the character “*” is shown
next to Sn in the column, this means that almanac data are unavail-
able for the corresponding satellite.

Fn GLONASS SV Frequency Number.

EL Elevation angle in degrees. The signs “+” and “-“ immediately fol-
lowing the elevation angles indicate that the corresponding satellites
are ascending and descending, respectively. If a satellite is at apo-
gee, it is marked with “*”.

AZ Azimuth in degrees

CA Signal-to-noise ratio (C/NO) in the C/A channel [dB*Hz]

P1 Signal-to-noise ratio (C/NO) in the P1 channel [dB*Hz]

P2 Signal-to-noise ratio (C/NO) in the P2 channel [dB*Hz]

TC Time elapsed since the last loss-of-lock in the C/A channel for the

corresponding satellite. This time is given in minutes or, if the sym-
bol “:” is specified in the column, in seconds.

SS Satellite navigation status. For a complete description of the satellite
navigation status structure, see Appendix C. If a satellite is not used
in position computation, its SS flag will be set to “-*“. Otherwise “+”
will be displayed.

Note that “??7” will be displayed everywhere in the panels where the
corresponding parameters are unavailable. The user can sort data in a column in
descending (ascending) order by clicking on the column’s title.
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Geo tab

The Geo tab shows the receiver’s antenna’s current position and the time-
frequency parameters describing the behavior of the receiver’s local

oscillator (Figure 2-3):

- Lat — latitude;
- Lon — longitude;

Gea IWZ lTarget'

Lat: B5° 42" E0.3005" M
Lews: 37 D5 25,0020 C
Al 2350116 m
Wel 0.0068 m/'s
AMS Pos: 0LDNEE m
RS Vel 00238 m/s
FOOP: 1.4313

[RTE fixed)
L3 100% (00 4070,0000)

Fieceiver time: 08:55: 37
Feceiver date 09.10.2001
Llock ottzet; +U.54510 ppm
Ozc. offset: +0.5315 ppm
Tracking time: 00:35:57

Figure 2-3. Geo Tab

Geodetic coordinates’

- Alt — ellipsoidal height.

* Solution type:
Standalone
Code differential
RTK float
RTK fixed

Vel — (magnitude of the) velocity (m/s).
RMS Pos — rms position error? (m).

RMS Vel - rms velocity error’ (m/s).
PDOP - Position dilution of precision.

1. These geodetic coordinates are computed in WGS 84 regardless of the current value of /par/pos/datum/

cur.

2. More precisely, this is the square root of the trace of the position error variance-covariance

3. More precisely, this is the square root of the trace of the velocity error variance-covariance
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* LQ - This field reflects the status of the received differential messages
and con-tains the following information:

Data link quality in percentage.

Time (in seconds) elapsed since the last received message.
Total number of received correct messages.

Total number of received corrupt messages.

If the receiver is not (for some reason) receiving differential corrections or if
none of the ports has been configured to receive differential corrections, the
field LQ will either be empty or it will look like this: 100%(999,0000,0000).
Currently the values for this filed are obtained from the [MS] message.

* Receiver time shows the receiver’s current time within day. This value
is taken from the message [~~]. For more information about [~~], see
the GRIL Reference Manual.

Currently the message [~~] reports the time within day in the
GPS time scale only.

* Receiver date shows the receiver’s current date as specified in the
correspond-ing [RD] message.

* Clock offset describes the time derivative of (Tr — Trr), where Tr
designates the receiver time, Trr designates the receiver reference time.
For more information about Tr and Trr, see the GRIL Reference
Manual. This parameter is obtained from the [DO] message and is
expressed in ppm.

* Osc. offset is derived from the message [OO] and it is expressed in
ppm. The parameter describes the difference between the VCO’s
nominal and quiescent fre-quencies.

* Tracking time is the time elapsed since the last complete loss-of-lock
event in the receiver’s C/A channels as specified in the corresponding
[TT] message.
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XYZ tab

The XYZ tab, which is shown in Figure 2-4, is similar to the Geo tab except
for the fact that the position of the receiver’s antenna is displayed in
Cartesian coordinates here.

Geo | ! Targeti
¥ 2057505,0212
Yo 21970068452
£ 52487870504
Vel 00366 nds
RAkS Pos: 4.7720m
RS Vel 00477 miz
PODOP: 16177
[standalong]

Receiver time 10:20:00
Receiver date: 28.02. 2002
Clock offset: -0,2123 ppm
Dsc. offset; -2 5872 ppm
Tracking time: 00:05:59

Figure 2-4. XYZ Tab

Target Tab

The Target Tab (Figure 2-5) is used to dysplay various navigation
information, specifically:

Geo |svz  Taget |

I ak BR® A3 AR 7220 M
Lon: 37" 36' Z4.5353" E
ETT: 1021.214 m
MTT: 1711.827 m
DTT: 1993.237 m
CTT: 30° 49'07.57"
FOOP: 1.86534

[RTK fized]
LG 100% [001,3187.0000)

Receiver time: 12:50:07
Receiver date 09.70. 2001
Clock offset; +0.5122 ppm
Ozc. offzet ; +0.5122 ppm
Tracking time: 04: 30: 27

Figure 2-5. Target Tab

 Lat, Lon —latitude/longitude of the target or of the receiver’s antenna.

* ETT, NTT - ‘Easting-to-target’ and ‘Northing-to-target’ in the local
system with the origin at the receiver.

e DTT - ‘Distance-to-target’ (in meters).
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e CTT - ‘Course-to-target’. The rest of the parameters have been
described above (see the Geo and XYZ tabs).

Notice: To set the target coordinates equal to the current receiver
coordinates, dou-ble-click on either Lat or Lon field.

Notice: To reset the timer in the bottom-right corner of the Main Window
fo 00:00:00, double-click somewhere in the hour:min:second
area.

Status Bar

The Status bar provides auxiliary information while using PCView. This
information includes the connection status, current communication settings,
various types of messages (e.g., error messages) and time since the
connection to the receiver has been established
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The Main window’s menu

The user can access any one of PCView’s dialog windows by selecting the
corresponding item from the main window’s menu (Figure 2-6). Some of the
menu items have shortcut keys.

For example, the user can select the Site item (from the Configuration menu)
with the keys CTRL+I.

Eile|§onfiguratinn Toole Plate Help

Figure 2-6. The Main window’s menu

The following sections will describe all available menu items and the
corresponding dialog win-dows in detail.

File Menu

The File menu contains six menu items:

Connect — By clicking this item, you open the Connection Parameters
window through which you establish the communication with a JNS
receiver. If the JNS receiver is already connected, this item will not be
available.

Disconnect — When you select this item, the connection with the JNS
receiver will be closed. If the JNS receiver is already disconnected, this
item will be grayed out.

File manager — Opens the File Manager window, which allows the user
to start/stop data recording into the receiver’s internal memory and to
manage log files collected with a JNS receiver. For more information,
see “File Manager Window” on page 2-11.

Real-Time Logging — Displays the Real-Time Logging window, which
allows the user to start/stop data recording into a computer drive. For
more information, refer to “Real-Time Logging Window” on page 2-18.

Manual Mode — Displays the Manual Mode window, which allows the
user to send commands to the receiver and view the responses. For
details, see “Manual Mode Window” on page 2-25.

Exit — Closes PCView.
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Configuration Menu

The Configuration menu contains four menu items:

* Receiver — Opens the Receiver Configuration window. This window
allows the user to adjust a wide range of receiver settings. For details,
see “Receiver Configuration Window” on page 2-27.

* Site — Displays the Site Parameters window, which allows the user to
enter site-specific information. For more details, see “Site
Configuration Window” on page 2-68.

* Target position — Displays the Target position window. For details, see
“Target position Window” on page 2-69.

* Radio — When selected, pops up the RFM96 button. Clicking this
button, opens the RFM96 Configuration window. This window
contains the controls that allow the user to configure the RFM96 radio
modem from Pacific Crest. For details, see “RFM96 Configuration
Window” on page 2-70.

Tools Menu

The Tools menu contains four menu items:

* Initialize file system — Initialize the receiver’s file system. For details,
see “Initialize file system” on page 2-75.

¢ Clear NVRAM - Clears the receiver’s NVRAM. For details, see “Clear
NVRAM?” on page 2-77.

e Reset receiver — Performs the receiver reset. For details, see “Reset
receiver” on page 2-78.

» Receiver options — Opens the Option Manager window. This window
allows the user to check the status of the receiver’s options and load an
OAF to a connected receiver. For details, see “Receiver options” on
page 2-79.

Plots Menu

The Plots menu contains four menu items:

* Scatter — Displays the Scatter Plot window, which shows the graphical
representation of the position the receiver computes along with the
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precision measurement information. For details, see “Scatter Plot
Window” on page 2-90.

* Satellites — Displays the Satellites Plot window, which shows the sky
plot of visible satellites. For details, see “Satellites Plot Window” on
page 2-92.

* Position — Displays the Position Plot window. For details, see “Position
Plot Window” on page 2-94.

* Configuration — Displays the Plots Configuration window, which
contains the controls related to Scatter Plot, Satellites Plot and Position
Plot windows. For details, see “Plots Configuration” on page 2-96.

Help Menu

The Help menu contains only one item:

About — Opens the About PCView window, which provides information
about the current version of the program, including its version number,
release and expiration dates. Also here the user will find some additional
information about a connected receiver. For details, see “About PCView
Window” on page 2-98.
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File Manager Window

www.javad.com

As its name implies, this window allows the user to manage the log files in the
receiver.

To open the File Manager dialog window, select the File Manager item from
the File menu, or press the Ctrl+F keys.
The user will be presented with the following tab controls:

* Download files — Allows downloading and deleting the log files from the
receiver memory. See “Download files Tab” on page 2-11.

* Current log file — Allows the user to start/stop data logging to a file and to
specify data logging rate, elevation mask, and site parameters. See “Current
log file Tab” on page 2-15.

Download path — Lets the user specify the full path and folder for the log files to
be downloaded from the receiver. See “Download path Tab” on page 2-17

Download files Tab

This tab lets the user download log files into a computer, or delete them
from the receiver memory (Figure 2-7).

@ Tile Manager

Download files | Currert log fiIeI Download pathl

Total memorny: 15802920 bytes Free memon: 15674400 bytes
| Mame | Sizel Datel Timel

" 1 gv25s 02082001 95705

» 19476 071.08.2001 123110

® Lin BE247  09.07.2001 11:35:36

® |g0709a 13237 03.08.2001 9.05:35

® |5g0709b 19863 09.07.2001 1318:58

Save tor cih

| Blocks: 16 [T Eiclisive made
Jzing: |Eurrenl port (COMT] 'I Block size: ii‘fld& bytes "I

Stop I [IElE=te I Hefresh I Bt |
| 45z | Downlading kin...

Figure 2-7. Download Files Tab
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Before downloading the desired log file(s) onto your computer, select the
folder on the PC where you want the file(s) to be stored. To do this, use the
Download path tab. For more information on Download path, look up
“Download path Tab” on page 2-17.

Once the destination has been specified, go to the Download files tab,
highlight file(s) you want to download onto the computer, and press
Download.

You will see the following color download status indicators in the course of
downloading the data:

* The green circle (%) indicates the file(s) that have been successfully
downloaded.

* The red circle (®) marks the file that is being downloaded.
* The blue circle (@) indicates the file(s) in the queue for downloading.
The user can interrupt the download by pressing the Stop button.

Files in the destination folder will have the same names and extensions as
the original receiver log files. Before downloading the current log file in the
destination folder, PCView will check if there already exists a file with the
same name in this folder. If such a file is found there, the user will be
prompted to select either Append or Overwrite (Figure 2-8). In the first
case the contents of the log file downloaded will be appended to the existing
file. In the second case the existing file will be replaced with a new file of

the same name.
The file

log0709a.jps
already existz. Do you want to cvenwrite the file or append to it?

Append I Cancel I

Figure 2-8. Message - a File with the Same Name Already Exists

WARNING: Care should be taken when selecting Append. This option is
normally used only if the downloading process has for some
reason been interrupted and you want it to be resumed.

The warning Last warning: Waiting for the 1st block
appearing in the status bar while downloading a log file indicates that
PCView cannot for some reason retrieve the next block of data from the
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receiver. The Retries field shows how many attempts to retrieve this block
of data have been made so far (Figure 2-9).

I Current log filel Download path |

Total memary: 15802920 bytes Free memary: 14623056 bytes
| Mame I Size i D ate | Time |

file bt 53376 3M./00 1625:09
last_but_one 101371 3100 16 40:06
last_try 286118 31400 16 46:56
meas_| 54970 31400 163358

® thur_mam 444733 3/2/00 1018:30
ver2_1 232727 31400 163322

Save to: C:\tmp1

| Reties: 17| ¥ | Exclusive mode

Using: | COkT [Current port] 5 Block gize: | 2048 byes ¥

Stop | [elete | Ee."e;hl it |

| B8 | Last waming: Waiting forthe 1st block

Figure 2-9. Message - Problem with Data Retrieving

If such a problem occurs, you may need to try a higher baud rate and/or a
smaller block size.

Usually, the larger the block size the more efficient
the data transfer. On the other hand, if the
connection between the computer and receiver is
not reliable enough, reducing the block size can
often help to exclude or at least minimize
communication errors.

Selecting the Exclusive mode checkbox will allow the user to increase
considerably the data transfer speed, especially if 115200 or a higher baud
rate has been set. Note however that using this option will disable most of
the processes running inside the receiver (including the satellite tracking
process) in order to ensure the highest possible file transfer speed.

One more note about downloading the receiver log files onto the
computer.If the Exclusive mode checkbox is not selected, one
can start downloading the current log file without closing it first.
The downloading process will stop at the moment when end-of-
file is reached in the log file.
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However the receiver will continue to write new data to the log file after
that.

This method has two drawbacks. First, the download progress indicator can
occasionally display values exceeding 100%. Second, the last record can be
corrupt in the downloaded file. If Exclusive mode is on, it is impossible to
start downloading the current log file without closing it first. In other words,
if the Exclusive mode checkbox has been checked and one wants to start
downloading the current log file, PCView will automatically close the log
file before the download is started.

Use the Delete button to erase unnecessary log files in the receiver memory.

To delete a group of log files, click on any one of them, then hold down the
Ctrl key and select the rest of the files, and finally press Delete.

To delete a group of adjacent log files, click on the first of them, then hold
down the Shift key and click on the last of the files, and finally press Delete.

Tip:  Log files that have inadvertently been deleted from
the receiver memory can be visible with the
command set,/par/dev/blk/a/removed,on. This
command can be sent to the receiver from the
Manual Mode window. The user is able to download
deleted files to the computer only if he/she has not
recorded any new files in the receiver memory since
these files were removed. Otherwise, it cannot be
guaranteed that the deleted files can be completely
downloaded.

With the Refresh button the user can reload the list of the receiver log files.
Press Exit to close the File Manager tab.
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Current log file Tab

In this tab the user can create new and delete existing receiver log files
(Figure 2-10).

“® File Manager
Download files  Current log file | Download pathl
Total memony: btes Free memony: 15651720 butes
I MNarme I Siz_e_l Datel Timel
1 8725 02082000 95705
2232 19476 01.08.2001 123110
5_floor 18973 13.08.200 11:2317
kin EEB247  09.07.2001 11:35:36
log0709a 13237 03.08.200 9:05:35
log0709b 19569  09.07.2001 131858
stat 3362 13.08.2000 11:23:48
Current file: gtat Size: 3362
File name: Isia-‘ Recording inter+al: |" 00 | [zeconds)
Site parameters | Elevation mask: |5 [degrees]
Siat | Delete I FRefresh | Exit | Stop |
[ |Data collection started

Figure 2-10. Current log file Tab

To create (open) a new log file, take these steps:

3.

Enter the desired filename in the File name edit box, or select a file
from the file list displayed in this window. In the latter case, just double-
click on the corresponding filename.

Specify the desired data recording interval (i.e., data update interval) in
the Recording interval edit box.

Set the desired Elevation mask.

Click the Site parameters button. The Site Configuration dialog box
will appear (Figure 2-11).

—Specify the desired Site Name.

—Select the correct Antenna Status from the corresponding list box.

—Set the Antenna Height parameter and select/deselect the Slant
checkbox depending on whether you have specified the slant or vertical
antenna height.

—Select the correct antenna type from the Antenna Type box.

—Set the Send parameters automatically checkbox. By default, it is
enabled. Disabling this checkbox, will prevent PCView from the
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automatic sending of the Site and Antenna Parameters to the receiver
on every log file creation event.

—Press OK.

@ Site Configuration

—Site Parameters

Site Name: iSite

Anterina Staus I Fixed i I

[Fiee
Maoving

—Antenna P,
Antenna Height [m]; |0 [ Slant

Antenna Type : lUNKNDW’N LI

OF. I Sendloreceiverl Canceli

Figure 2-11. Site Configuration Dialog Box

Notice: After pressing the OK button, the Site parameters dialog box will
be closed and the parameters that have been specified in the
box will be copied to pcview.ini. If the user then presses the
Start button in the File Manager window, these settings will be
enabled and inserted into the newly created (current) log file,
unless the user disabled the Send parameters automatically
button. On the other hand, if the user needs to update the site
information for the log file being recorded, it will be sufficient to
press the Send to receiver button to send the new site settings
(site name, antenna status, antenna height, etc.) directly to both
the receiver log file and pcview.ini.

Notice: If you set a recording interval that is not currently supported by
the receiver, PCView will launch a utility Output Period Setup
Wizard. For more information on the Wizard, see Appendix B on
page C-1.

To stop data recording and close the file, click the Stop button.
The rest of the controls are described in Table 2-2.

Table 2-2. Current log files Controls

Control Description

Current file Shows the name of the file the data is being
logged to.
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Table 2-2. Current log files Controls
Control Description
Size Reflects the size of the current log file. To

keep track of the data recording process, see
how the log-file size varies in time.

Total memory Shows the total amount of space in bytes (in

the receiver) available for data.

Free memory Displays how much space in the receiver is

free for storing data.

Delete, Refresh, Exit Serve the same purposes as in the Download
file tab (see “Download files Tab” on
page 2-11).

Download path Tab

In this tab the user selects the destination folder for the files downloaded
(Figure 2-12).

@ File Manager

Download filesl Curent log file  Downlaad path

(= o Taw.jps

Espreinnenls SUper.ps

=1 =l

Mew folder: | [EfEate

Figure 2-12. Download path tab

Note that the window's right panel is for display only. The user will be
prevented from doing any operations on the files in the corresponding
directory. If the user has not explicitly selected a destination folder for the
files downloaded, these files will be stored based on the last specified
download path.
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Real-Time Logging Window

The term real-time logging means recording receiver data into a PC in real time
mode.

To open the Real-Time Logging window, select Real-Time Logging from the
File menu or press the Ctrl+R keys.

The Real-Time Logging dialog boxes (see Figure 2-13 on page 2-19 and
Figure 2-14 on page 2-20) are, structurally, similar to the Main window. For a
description of the GUI components that are identical for the Real-Time Logging
and Main windows, refer to “Understanding Elements of the Main Window” on
page 2-2. Below we will focus on the components specific to the Real-Time
Logging window.

Note the three tabs in the top-left corner of the window: Single file, Multiple
files and Select output path. For information on the Select output path tab,
refer to “Download path Tab” on page 2-17.

Before we getting down to the other two tabs, consider the parameters displayed
in the middle of the Real-Time Logging window, between the GPS Satellites
and GLONASS Satellites tables.

The Elapsed time field shows the time elapsed since the current log file was
opened. Every time a new log file is created, this timer is reset to 00:00:00.

The Received field shows the log-file size in bytes. This parameter will vary as
new data are recorded into the file. After pressing the Stop button, one will see
the log file's final size in the field.

The Site parameters button allows the user to enter various antenna and site
parameters. For details, see “Site Configuration Window” on page 2-68.

The Start button allows the user to start recording data into the file. After
starting the data logging the name on the button will change to Stop. Pressing
the Stop button will close the file.

Notice: If the user sets a recording interval that is not currently
supported by the receiver, PCView launches a utility called
Output Period Setup Wizard. For more information on the
Wizard, see Appendix B on page C-1.

By pressing Exit you will close the Real-Time Logging window.
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While the value of Recording interval specified in the Real-Time
Logging window applies only to this mode, the Elevation mask
edit box also affects the Terminal Elevation Mask setting.

In real-time data logging mode it is recommended that the RTS/
CTS handshaking checkbox be selected and the baud rate be
set to 115200 or higher.

Unlike downloading the recorded log files from the receiver
memory onto the computer, real-time data logging does not use
any error detection/correction protocol in the course of the data
fransfer. As a result, some of the messages in the created JNS
files may be corrupt (due to the serial port overrun or similar
problems). More precisely, some of the transferred bytes may be
lost on the computer end.

Single file Tab

In this mode PCView will record receiver data into one specific file on the
host computer. Figure 2-13 shows an example of the Single file tab of the
Real-Time Logging window.

Real-Time Logging
& Mulinle fles | Salert nutpt path |

Save to; [test ps
Output path C:4
GFS Satellites [8] GLOMASS Satellites (4]
0 | EL] aZ] ca] P1] P2] 1c] Receiver Position  [Sn [ Fn | EL] AZ[ ca] P1] P2] 1|
04 30+ 50 45| 30 30 204 et 2603957.0307  [pg (0B |31+ | 42[ 47| 46[ 33[ 4
05 63 150 53 44 44 235 bl 21969960138 |47 05 B3. 7B 53 G4 44 122
05 | 37+ 246 47 | 34 35 82 b 52467669884 |18 10 | B+ 262 33 33 3/ &
09 14+ 182 42 24 23 3T Vel 0.0505més 24 |03 B3 B0 B4 B3 47 22
14 7+ 2 41 18 18 184 FOOP 14073
gé g?* 3?2 3; ;E gg 1210 Receiver date: 22,013 2002
= ]
30 |73 266 | F3| 43 43 165 Receiver time: 07:32:26
Elapsed time: 00:00:00
Hecerved:

Recording interval: [1 [seconds] Bt | Eleyation mask: [5 [degress]

| 7

Figure 2-13. Real-Time Logging Window - Single file Tab

To start real-time data logging into a single file on the host computer, follow
these steps:

1. 1In the Save to edit box enter the name of the file where the receiver data
are to be logged.
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Notice: By default the name of a JNS file created in real-time logging
mode will coincide with the site name from the Site Configuration
dialog box.

2. Specify the Site parameters, Recording interval and Elevation mask
settings.

3. Click the Select output path tab and then specify the full path for the
file in the Save to edit box.

4. Return to Single file. Click Start to begin logging.

Multiple files Tab

This function, real-time logging of multiple log files, is intended to automate
the process of real-time recording of the receiver data to JNS files according
to the specified time schedule.

In this mode PCView will automatically open/close JNS files in regular time
intervals. A new JNS file will be opened immediately after the previous file
is closed. By selecting the Multiple files tab, the user will be presented with
a window that looks like Figure 2-14.

2 Real-Time Loggin

Prefis: [Site Numbering [Date & Tme 7| Mest file every: [1 hows | [ Autocorvet to RINEX
Currert file: Seart Goumt |0 I~ Overmile existing files Stelup wurelen
Dulput path Ex4
6PS Satslites (8) GLONASS Satellites (5]

W [ EL] Az[ cal PI] Pl TC] Receiver Position  [5n [ Fn | EL| az] Ca] P1] P2] 10]
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Figure 2-14. Real-Time Logging Window - Multiple files Tab
The filename convention settings Prefix and Numbering determine how
the JNS files created will be named.

As the name of the setting implies, Prefix determines the prefix part of the
filename. By default, PCView will use the site name specified in the Site
Configuration dialog window as the filename prefix.

The Numbering edit box allows the user to select the desired file
numbering scheme:
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* If the Date & Time option is selected, the numeric part of the filename
will look as follows:
YDDDHHMM, where
Y — last digit of the year [0-9]
DDD - day of the year [1-366]
HH — hours in the receiver time scale [00-23]
MM - minutes in the receiver time scale [00-59]
The date and time used for the filename will correspond to the first
epoch recorded into the file.

* If the Ascending Count option is selected, the numeric part of the
filename will vary between 0000 and 231147483647.

If the Ascending Count option has been chosen, the parameter Start
Count will be enabled. In this edit box the user can enter the starting
state of the JNS file count, (i.e., the numeric part of the name of the JNS
file created first). This count will be increased as new JNS files are
opened.

New file every is associated with a pair of components, an edit box and a
drop-down list box. Use the list box to select the desired time unit (day, hour
or minute). Use the edit box to specify the interval (in the selected time unit)
in which the current JNS file will be closed and the next one will be opened.

Note that this interval must be an integerl. Also note that some of the
multiple files created may be shorter (in terms of their duration in time) than
it is specified in the corresponding edit box.

To better understand how multiple files are opened and closed in multiple
file mode, let us consider the artificial time scale with the origin at

0h00mO0s> as shown in Figure 2-15 on page 2-22. This time scale is
divided into intervals equal to the period as specified by the New file every
fields.

The first of the multiple INS files will be opened immediately after the
Start button is pressed.

The first file will be closed and the second one opened as the 2nd interval
starts, for example, at t=2n (Figure 2-15), etc.

Time duration of the second and all the following multiple files (maybe
except the last one) will be exactly equal to the selected file period.

1. Whatever time unit is selected.

2. That is, at the beginning of the day when multiple file logging is started by pressing the Start button.
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To stop the multiple file data logging, press the Stop button. Note that the
last file, too, can be shorter than is specified in New file every.

Duration of  Duration of Duration
First file second file of lask file
e ——
| A 3 1 1 ! N »
I e T T T T 5N 1 Ll
ohoomogs n 2n an 4n {i-1)sn i*n

+— open time for the first file
X - close time for the last file

n - period specified in New file every:

Figure 2-15. Generation of Multiple Files

If the user wants PCView to overwrite the existing files whose names
coincide with the names of the newly created files, select the Qverwrite
existing files checkbox before starting real-time logging.

For example, assume that the Ascending Count and Overwrite existing
files options have been selected. If the user then presses the Start button,
PCView will display a prompt as in Figure 2-16.

Al files with such names as Site0000 jps, Site0001 jps etc
vesiding in the folder E:ve-s-dbiraw_data
will be ovenwritten without warning. Continus?

I

Figure 2-16. Overwrite existing files? Warning

In this example the destination folder is E:\c-s-db\raw_data, the
filename prefix is Site.

Press Yes to overwrite the existing files. If you press No, you will return to
the Real-Time Logging window. There you will need first to uncheck the
Overwrite existing files checkbox and then press the Start button to start
data logging. In this case the numeric parts of the names of the JNS files
recorded will be incremented starting from the first unused value, not
necessarily from 0000.

If the Autoconvert to RINEX checkbox is selected, PCView will
automatically convert all newly created JNS files to RINEX. Note that this
conversion is performed on the move.

Notice: If you want to use the Autoconvert to RINEX function, make sure
that the executable file jns2rin.exe is available on your computer.
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The Setup converter button, which is located immediately below the
Autoconvert to RINEX checkbox, allows you to set up some of the options
used by the Jps2rin.exe converter. Pressing this button will open the
Converter to RINEX Setup window (Figure 2-17).

onverter to RINEX Setup

_PTDDUILiI:b
Run b |L| B[

Observer |Sur\-'eyor

Agenay I INS

Antenna |DD2 Antening type: I Mardnt

Commne:: |This comment will appear in RIMEX files

Marker name: |Site

Marker number: |359

~Converter
Application: |E:'\FHNE><_conveﬂer\ips2rin.exe Brawse |
[~ Exclude GPS [~ Esclude L1

[ Exclude GLONASS [~ Esxclude L2
[ Delele source JPS files after successtul conversian
ALdditional optiors: I

oK I Cancel |

Figure 2-17. Converter to RINEX Setup Window

The information specified in the Properties panel will be put in the header
of the corresponding RINEX files:

* Run by — name of the person or agency launching the converter.
* Observer — name of the person who collected the data.

* Agency — name of the agency responsible for collecting the data.
* Antenna # — antenna number to be copied in the RINEX files.

* Antenna type — antenna type to be copied in the RINEX files.

¢ Comment — comment line(s).

* Marker name — name of the antenna marker.

* Marker number — number of the antenna marker.

In the Application edit box, the full path to JpsS2rin.exe must be
entered. Use the Browse button to select the desired filename path instead
of typing it.

Use the Exclude GPS (Exclude GLONASS) checkbox to exclude from the
resulting RINEX files all raw data measurements/ephemeris data
corresponding to GPS (GLONASS).
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Use the Exclude L1 (Exclude L2) checkbox to exclude from the resulting
RINEX files all L1 (L2) raw data measurements.

The Delete source JPS files after successful conversion checkbox means
exactly what its name implies.

In the Additional options edit box you can enter any of the switches
available for the windows console application Jps2rin.exe. For more
information about the switches, refer to the Free Software section at
Support area of http://www.javad.com
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Manual Mode Window

Notice:

www.javad.com

This window, as shown in Figure 2-18, allows direct control of the receiver by
using GRIL commands. In manual mode PCView serves as a terminal
communicating with the receiver, (i.e., it allows the user to send various
receiver commands and get responses to these commands). For a complete list
of commands supported by JNS receivers, refer to the GRIL Reference Manual.
This document is available for download from the JNS website (http:/
www.javad.com/.

& Manual Mode —[Ofx

s%print, /msg/ nmes:on| -

BE023%%{(U—,6378137.0000,295.257223563}, =
REO45%% {USER,0,+0.0000,+0.0000, +0.0000, +0.00000, +0.00002, +0.00000, +0.00
REOZ3%%/msg/ nmea={3GA={1.00,0.00,0,0x0} ,

REO19%% GLL={1.00,1.00,0,0x0},

BEO19%% GNS={1.00,J.00,0,0x0},

REO19%% GRS={1.00,1.00,0,0x0},

FEO19%3% GSA={1.00,1.00,0,0x0},

REO19%% GST={1.00,1.00,0,0x0},

REO19%% GSV={1.00,1.00,0,0x0},

REO19%% HDT={1.00
REO15%% RMC={1.00,3.00,
REO19%% ROT={1.00,.00,
REO15%3% WTG={1.00,3.00,
REO1S%% ZDA={1.00,3.00,
REO1E%% P_ATT={1.03,0.0

.00, 0,0x03,
,0x0%,
,Ox0%,
S0x03,
L O0x0%,
,0,0x0}}

UuuULLLL LY

o
o
o
o
o
o
o
o
o
o
o
o

< | ;l;l

Send command | | Stop ol messages | Clear window Exit Discornect | Startlogging |
Load script | Path: C:'Genersl folder\GRIL_PCCDUNPe-cdulSeripts Edit soript__ |

[ Z

Figure 2-18. Manual Mode Window

To go to the Manual Mode window, select the Manual Mode item from the
File menu or press the Ctrl+M keys.

We recommend that you do not send any commands to the
receiver from the Manual Mode window before you familiarize
yourself with the GRIL Reference Manual and acquire good
knowledge of the receiver parameters.

At the top of the Manual Mode window there is a command line box in which
the user can type a (new) command line. Alternatively, the user can click ] to
open the combo-box list and select one of the previously used command lines.
Note that there may be stored up to twenty (20) command lines in the list. Once
the desired command line is typed (or selected), press the Send command
button in the bottom-left corner of the Manual Mode window or just click the
Enter key on your keyboard. The receiver's responses will be displayed in the
receiver replies window located under the command line box.
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The other controls available on this window are summarized in Table 2-3.
Table 2-3. Controls of Manual Mode Window

Control Description

Stop all messages Stops outputting any messages from the receiver to the current
terminal. After the button is pressed, PCView will send an
appropriate dm command to the receiver.

Clear window Clears the receiver replies window.
Exit Closes the Manual Mode window.
Disconnect Allows the user to disconnect from the receiver without dis-

abling any configuration changes made.

Start logging Allows the user to copy to a file on PC all information that has
been displayed in the receiver replies window during the ses-
sion.

Edit script Allows the user to modify the contents of the script files.

Load script Loads into the receiver the desired script file.
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Receiver Configuration Window

Notice:

www.javad.com

To go to the Receiver Configuration window, select Receiver from the
Configuration menu, or alternatively press the Ctrl+V keys.

The user will see a dialog window comprising eight tabs, as shown in Figure 2-
19 on page 2-28.
Each tab has Apply and Refresh buttons.

* Apply — instructs PCView to accept and send to the receiver settings made
in the tab without closing the window.

Each Apply button serves only its own tab and cannot affect the
other tabs' settings.

* Refresh — updates the currently displayed window with information from
the receiver.

In addition, the following four buttons are available and common for all tabs.

* OK - unlike the individual Apply buttons, allows you to accept the selected
settings for all eight tabs at a time and once accepted, to close the Receiver
Configuration window.

» Exit — closes the Receiver Configuration window without accepting the
settings you have made since Apply was pressed last.

» Save — opens the Save setup to a script window. In this window you can
save the current receiver settings to a script file. Script files normally have
the extension .jpc. Later you can load the desired script file to the receiver,
thus enabling several necessary receiver settings with a single operation.

* Set all parameters to defaults — does exactly what its name implies.
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General Tab

Figure 2-19 shows the Receiver Configuration window's General tab.

iver Configuration

MinFad i PDS\[IDHIHQI Base | Hoverl Parts i Evantsi Advancedi

~Elevation mask [degressf——————— | —F"D:wa management

Power———————————— Voltages [valts]—

Termind Elevation Mask I5
Mode IAul( 'i Erteris

[Antenna | | Antenna Status [read only] Curent Mode I'[- OnBoard: |72
£ rteial

Curtent Input:— [=xt 7 =
€ Eptermal i Battery 4.2 |7 £1

Bt Ext. DC Status IoH Made IAutc vI
Battery B : [/ 41
Temperature [Celsius degrees)——————— Speedl I uf l

Board temperature ; IZSE Cunent Made Im Charger; |7 41

Power output modes———— - Turn on/ofl Slots—

Parts - On 'l ¥ Slat2
v Slet3
Slots : On = ¥ Slot4

¥ Enable Low Power Mode

Refresh | SEpl

‘ Ok I Exit I Save I Selallparameterstodefaultc|

Figure 2-19. General Tab

Elevation mask

In the Terminal Elevation Mask edit box the user enters the minimum
elevation (i.e., the elevation mask angle) for the satellites whose data will be
output to the current terminal (i.e., the receiver port being used for
communication).

Antenna

The Internal, External and Auto radio buttons are used to select the
desired antenna type.

Notice: Note that some receiver models are capable of automatically
detecting an external antenna only at receiver start-up time.
Therefore if one wants to switch from the internal antenna to an
external one while in auto, he/she will have to power the receiver
off and then back on.

Antenna Status

The Current Input indicator shows what antenna type is actually being
used by the receiver:

* int — the internal antenna is being used.

* ext— an external antenna is being used.

2-28 PCView Software Manual www.javad.com



www.javad.com

LEARN PCVIEW IN DETAIL

Receiver Configuration Window

The Ext. DC Status indicator shows if the external antenna draws any DC
power:

* off — the external antenna draws no power.
* normal — the external antenna draws normal power.

* overload — the external antenna draws higher power than expected or a
short circuit occurs in the antenna or antenna cable.

Temperature

The Board temperature indicator shows the receiver board's current
temperature in degrees of Celsius.

Power management

There are five group boxes that allows the user to adjust/view the power
settings for your receiver. Each group box contains a set of related controls.

Power

Use the Mode drop-down list box to select the desired power source for
the connected receiver:

* Auto — receiver will automatically select the power source.

* Mix — receiver will automatically consume power from the source
with the highest voltage.

* Battery A — receiver will consume power only from battery A.
* Battery B — receiver will consume power only from battery B.
» External — receiver will use an external power supply.

The Current Mode indicator shows what power source is being used at
the moment.

Charger

Use the Mode drop-down list box to select the battery charging mode:
* Off — receiver will not charge the batteries.
* Charge A —receiver will charge only battery A.
* Charge B — receiver will charge only battery B.

* Auto — receiver will automatically detect and charge the detected
batteries.

Use the Speed list box to set the desired speed of battery charge cycle
(available not for all receiver models). You can select between Normal
and Fast charging modes.

The Current Mode flag shows which of the batteries, a, b or none (off)
is being charged at the moment.
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The Current (Amp) field reflects the actual battery charging current in
Amperes.

Power output modes

The Ports A,B checkbox allows you to turn power on and off for ports
A and B. This parameter is applicable to the Prego receiver only.

With the Port C checkbox you can turn power on and off on port C.
This parameter is applicable to the Odyssey receiver only.

The Ports list box governs power output on serial ports:

* On - the power board will feed all available serial ports via the
corresponding pins when the receiver is turned on. If the receiver is
turned off, there will not be any power on the ports.

* Off — power, for all available serial ports, will be absent even if the
receiver is turned on.

* Always — all serial ports will be powered even if the receiver is
turned off.

With the Slots list box the user governs power output to the receiver
internal slots:

* On — means that all slots are powered if the receiver is turned on. If
the receiver is turned off, there will not be any power on the slots.

* Off — means that internal slots will not be powered even if the
receiver is turned on.

* Always — means that internal slots will be powered even if the
receiver is turned off.

Notice: The Ports, Slots list boxes are applicable to the Maxor and Prego
receiver families only.

Voltages
The External indicator shows the external power supply's voltage.

The On Board indicator shows what is the actual voltage presented on
the receiver board.

The Battery A and Battery B indicators show the voltage on batteries
A and B, respectively.

The Charger indicator shows the output voltage of the internal charger
during battery charging.

The On Ports indicator displays the output voltage on the first pin of
each of the receiver’s serial port.
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Turn on/off Slots

Select the Slot 2 (C), Slot 3 (B) and Slot 4 (D) checkboxes to enable the
corresponding internal slots.

Notice: The Turn on/off Slots group box is applicable to the Maxor and
Prego receiver families only.

If the Enable Low Power Mode checkbox is selected, the receiver's
processor will go into low power consumption mode.

MinPad Tab

In this tab (Figure 2-20), the user can configure receiver parameters which
relate to MinPad (user simple interface).

% Receiver Configuration

I Posilioningl Base I Hover' Paits i Eventsi Advancadl

Recording interval : I1.DD [eeconds] —FM key mode

Elevatior mask for Lag file - |5 [dedraes] ' LED blink mode swich ¢ Occupation moce switch
File name prefis : log [ Initial data collection dyramic mode
Always aspend to the file : I S £ Kiremate |
~Filzs Creation mode: —Data recording auto-start
[ = Logile £ ATTIM | = 0ff  On O Alayy |
—Automatc File Rotation Mode [AFF) parameters

(FEradi{sea]] 3500 Fles Thatal ] IL'I

Fhase (sec] |0 Eiles remat] .IG

= Eutamatically iemove sld files

Riefresh Apply

| Ok I Exit I Save I Seta\lparameterstndafault:I

Figure 2-20. MinPad Tab

Recording interval

The recording time interval specified in the Recording interval edit box
will be used when receiver files are opened and logged via MinPad, (i.e., by
pressing the FN button). This setting is used not only when logging a single
log file but also when logging receiver data in AFRM mode. Note that this
parameter cannot exceed 86400 seconds.

Notice: If an incorrect recording interval is set (the Recording interval
edit box), PCView will run a utility called Output Period Setup
Wizard. For more in-formation on the Wizard, see Appendix C on
page C-1.
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Elevation mask for Log file

This control specifies the minimum elevation angle for the satellites whose
data will be put in the receiver files logged when pressing FN.

File name prefix

This setting specifies what prefix will be added to the names of the receiver
files created via MinPad, (i.e., by pressing FN). The prefix can be up to 20
characters long. Default is log.

Always append to the file

If the new receiver data are to be appended to an existing log file, enter the
desired filename in the Always append to the file edit box. The setting can
be up to twenty characters long.

Files Creation mode

Two operation modes are possible for the FN button. If the Log file radio
button has been selected, pressing FN will result in closing the current log
file or, if data logging has been off, opening a new log file. If AFRM has
been selected, pressing FN will enable this mode, if it has been disabled,
and vice versa.

Automatic File Rotation Mode (AFRM) parameters

* Period — specifies the time duration of each of the multiple log files
created in AFRM mode.

» Phase — specifies the phase (i.e., constant time shift) of the multiple log
files created in AFRM mode.

* Files (total) — specifies how many multiple log files must be created in
AFRM until this mode automatically turns off. Zero means that an
unlimited number of log files will be created.

* Files (remain) — shows you how many log files are left for the receiver
to create in AFRM.

* Automatically remove old files — if selected, the receiver will remove
the least recent files if no free space is available in the receiver memory
to record the current file.

FN key mode

These two radio buttons are used to program how the receiver will react to
clicking FN (i.e., keeping the button depressed for less than one (1) second).
In LED blink mode switch mode, clicking FN will toggle between the
MinPad's standard and extended information modes. For more details, see
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the MinPad User's Manual. In Occupation mode switch you click FN to
get the receiver to insert into the corresponding log file a message indicating
that the occupation type has been changed from static to kinematic, or vice
versa.

Initial data collection dynamic mode

These radio buttons specify the starting occupation type descriptor that will
be inserted at the beginning of each receiver files logged via the MinPad.
You select Static and Kinematic to specify that the corresponding log file
will start with a static and kinematic occupation, respectively.

Data recording auto-start

The user can program how the receiver will behave in the event of a power
failure.

Depending on which of the three radio buttons has been selected, the
receiver will behave as given in Table 2-4 (specified file refers to the file
name entered in the Always append to the file field):

Table 2-4. How Data recording auto-start Works

Before Enabled Radio Button Results

Power

Failure Off Oon Always
Receiver data | Data logging will Receiver will Receiver will resume

logged to file
specified.

not resume when
power is restored.

resume data log-
ging to the same
file when power
is restored.

data logging to the
same file when power
is restored.

Receiver data
logged to
default file.

Data logging will
not resume when
power is restored.

A new log file
will open when
power is restored
and data will log
to this file.

A new log file will
open when power is
restored and data will
log to this file.

Receiver data
logging not
started and
file specified.

No file will open
with this name.
Data logging will
not start when
power is restored.

No file will open
with this name.
Data logging will
not start when

power is restored.

A log file with this
name will open and
data logging will start
after power is restored.

Receiver data
logging is off
and no file
specified.

Data logging will
not start when
power is restored.

Data logging will
not start when

power is restored.

A log file with a
default name will open
and data logging will
start after power is
restored.
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Notice: Also, if the Always option is selected, your receiver will
automatically start logging data (to a newly created or an
existing file) in the following three cases:

1. After turning on the receiver using the Power key.
2. After resetting the receiver (using PCView or pressing the Reset key).
After taking the receiver out of Sleep Mode.

Positioning Tab

This tab contains various controls and fields that allow the user to set
elevation and PDOP masks, to select satellites to track, and to specify what
measurements to use in position computation (Figure 2-21).

% Receiver Configuration
Genarali MinFad | Base | Hoverl Ports i Evantsi Advancedl
~Pogitionng Mode———— [ Enable Solutions—— [~ Satellite management
+ Standalone ¥ Standalohe —Satellites tracked 1 Satelltes used inpcs——
= DGPS [Code Differential] ¥ BEEE ¥ GPS ¥ GLOMASS | ¥ GPS ¥ GLOMASS
£ RTK Float I¥ | Bt Flaet =
 RTE Fised ¥ R Fired | GLonass | weas|
Fositi Mk Positioning & pm|\0ck|use| prnllock ise! pm\lock|usei prnllozk| use|
Positionng Masks—— [~Positioning System
Elevation mask IE’_ W GPS Wr_;;_ ol 3[_':7_ o W'? 'z 25'2 r:-
[deqes] 2 v U v 1HlY W Bl
PDOP mask:  |30.00 [ GLONASS WV ¥ 8F ¥ ZF
¥ Ré&lM Enabled ~Measurements Used cEhE e o i 2
I !N—:I & CAMLT 5V W 1BV VM 2V W 2l W
- -
arm on-precision r(: E::EZ P P UR R 2P ab
Al 5556  loroFies i 5 7 23 3Rk &
8V W 1BV V¥ AV M 2V ¥
Current Diatum : I I '
O N | o ITnnn EE"EDUD_"' Al ta lock | Nane to \ockl Al to use I Naneto usaI
Dstum Parameters I vfionata s o
Advanced Eosticnmg Setings I Refresh | e 1 I
Ok I Exit | Save I Set all parameters to default: |

Figure 2-21. Positioning Tab
Positioning Mode

These four radio buttons permit the user to select one of the four available
positioning modes.

Enable Solutions

If the Standalone checkbox has been checked and the rover receiver is
being run in differential mode, the receiver will report its current standalone
position instead of the DGPS (or RTK) position if the latter is unavailable in
the current epoch.

If the DGPS (Code Differential) checkbox has been checked and the rover
receiver is running in RTK Float or RTK Fixed mode and is unable to obtain
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an RTK solution at the current epoch, it will output the current code
differential position for the unavailable RTK solution.

Notice: If the DGPS (Code Differential) checkbox is enabled and a
DGPS solution cannot be obtained, you can instruct the receiver
to output single-point position for the unavailable differential. For
this, enable the Standalone checkbox.

Notice: Code differential mode requires broadcasting the corresponding
DGPS (not RTK) messages from the reference receiver and
accepting them on the rover receiver. If any of these
requirements are not met, then enabling the DGPS (Code
Differential) checkbox will not have any effect.

Notice: The checkboxes RTK Float and RTK Fixed are always grayed
out in this version of PCView.

Positioning Masks

* In the Elevation mask edit box you specify the elevation mask angle
for the satellites used in position computation. The receiver will not use
the satellites below the specified elevation mask to compute the
position. The default value is 5 degrees.

* In the PDOP mask edit box you specify the threshold value of PDOP
that disables position computation. If PDOP exceeds this mask during a
period of time, the receiver's position will not be computed over the
corresponding epochs. The default value is 30.

RAIM Enabled

RAIM stands for Receiver Autonomous Integrity Monitoring. When this
feature is enabled, the receiver continuously checks whether the signals
received from satellites are usable or not. If a fault (measurement outlier) in
satellite data has been detected based on the current alarm limit, RAIM
excludes this satellite(s) from the positioning calculations, thereby allowing
the receiver to continue providing correct position information without an
interruption in the service.

e The RAIM Enabled checkbox, if selected, activates the RAIM
algorithm.

* With the Alarm setting, the user specifies alarm limit mode. The alarm
limit is a threshold value for the horizontal radial error. There are three
pre-defined limits and one that is specified manually:
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-Non-precision stands for Non-precision approach. For this phase of
flight the alarm limit is equal to 0.3 nmi. This value means that an error
of 0.3 nmi or greater, caused by bad satellite data, will be detected by
RAIM.

-Terminal. For this phase of flight the alarm limit is 1.0 nmi.
—En route. For this phase of flight the alarm limit is 2.0 nmi.

—Manual. This mode allows the user to select alarm limit values other
than the pre-defined ones.

* The Alarm limit edit box is available only if one has selected the
Manual mode from the Alarm list box. Values the user enters in this
edit box can vary within the range 10.0...10000.0 meters. The default
value is 555.6 and it corresponds to Non-precision approach.

From the Current Datum drop-down list box you select the datum used in
position computation. Once the desired datum is selected and the Apply
button is pressed, the receiver begins producing its position expressed in the
selected datum. The default datum is WGS 84.

Notice: Currently JNS receivers support more than 200 datums. For a list
of the supported datums, refer to the GRIL Reference Manual.

Notice: The receiver position, which is expressed in a datum other than
WGS 84, may be viewed using NMEA messages such as GGA,
GLL and so on. Position-related JNS messages (for example
[PV]) always contain the coordinates computed in WGS 84.

Pressing the Datum Parameters button will open the <Datum ID> Datum
Parameters window (Figure 2-22 on page 2-37). In this window the user is
able not only view the ellipsoid and transformation parameters of the
datums selectable from the Current Datum list box but also edit the

transformation parameters for a user-defined datum (USER) and the P90

datum’.

1. P90 is the datum ID of the GLONASS reference frame PZ-90 (Parametry Zemli or parameters of the
Earth).
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In addition the ellipsoid parameters of USER can be edited in this window.

% w84 Datum Parameters

i~ Transformation parameters

Referencs Datum : |ﬁ€ﬂ j
Current Datum ; Translaticnd®:  {+0.0000 [
Translaticn d ' : I*f‘ 0000 [rn]
Translationd2:  |+0.0000 [
i~ Reference Ellipscid parameters ) — .,
Rotation Ry : +0.00000 "

Ellipsaid 10 : 4/

Rotation Ry : I +0.00000 "
Ratation Rz : I +0.00000 "
Scale: I +0.00000

Ok I Cancel I Refresh I Snply |

Major semi-asis;  |5375157.0000 | ]

Ireerze fathening: | 295257222063

Figure 2-22. <Datum ID> Datum Parameters Window

Current Datum

Select the desired datum ID from the pull-down list to examine (for pre-
defined datums) or edit (for user-defined and PZ-90 datums) the ellipsoid
and transformation parameters.

Reference Ellipsoid parameters

* Ellipsoid ID — Two-letter identification code. Displays U- for a user-
defined ellipsoid.

* Semi-major axis — The semi-major axis length in meters. Ranges from
6300000.0 to 6500000.0.

* Inverse flattening — The reciprocal of the ellipsoid flattening
(dimensionless). It must be a positive value between 280.0 and 310.0.

The semi-major axis and Inverse flattening fields are only
available for modifying if the selected datum in the Current
Datum list is USER or P90.

Transformation parameters

» Reference Datum — The datum relative to which the user specifies the
transformation parameters.

This field is only available for modifying if the selected datum in
the Current Datum list is USER.
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* Translation dX — The shift value along the X axis used to relate the
origins of a pre-defined or user-defined datum and the selected
reference datum. Ranges from -10000.0 meters to +10000.0 meters.

* Translation dY — The shift value along the Y axis used to relate the
origins of the two datums. Ranges from -10000.0 meters to +10000.0
meters.

* Translation dZ — The shift value along the Z axis used to relate the
origins of the two datums. Ranges from -10000.0 meters to +10000.0
meters.

* Rotation Rx — The rotation angle around the X axis used to relate the
orientation of a pre-defined or user-defined datum and the selected
reference datum. Ranges from -60" to +60".

* Rotation Ry — The rotation angle around the Y axis used to relate the
orientation of the two datums. Ranges from -60" to +60".

* Rotation Rz — The rotation angle around the Z axis used to relate the
orientation of the two datums. Ranges from -60" to +60".

e Scale — The scale factor used to account for any changes in scale
between the two datums. It ranges from -1000 ppm to +1000 ppm.

Notice: These transformation parameters are only available for
modifying if the selected datum in the Current Datum list is
USER or P90.

Notice: Click Apply, then OK to accept configuration changes and close
the window.

Positioning System

Select the GPS and GLONASS checkboxes if it is desired that the
corresponding satellite constellations to be used in position computation.

Notice: However the selected satellite constellation will indeed be used
in position computation only if the corresponding Satellites used
in pos. checkbox from the Satellite management panel is
selected as well.

Measurements Used

This radio button group shows what code measurements will be used to
compute the receiver's standalone position. This parameter applies only to
absolute position computation.
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For a single-frequency receiver, the radio buttons P/LL1, P/L.2 and
lono-Free will be gray.

If the Iono-Correction checkbox is selected, the receiver will correct the
pseudoranges for ionosphere (based on the model defined in ICD-GPS-200,
Revision C) before using them in position computation. Note that if both
Iono-Free and Iono-Correction are selected, the first overrides the second.
This parameter applies only to absolute position computation.

If the Tropo-Correction checkbox is selected, the pseudoranges will be
corrected for troposphere before being used in position computation. This
parameter applies only to absolute position computation.

Satellite management

1. Satellites tracked

The GPS and GLONASS checkboxes are used to allow tracking of
GPS and GLONASS satellites, respectively.

2. Satellites used in pos.

Use the GPS and GLONASS checkboxes to specify what satellite
systems (only GPS, only GLONASS, or both) will be used in position
computation.

3. GPS | GLONASS | WAAS

Use these tabs to explicitly specify which of the GPS, GLONASS and
WAAS satellites are enabled for tracking and position computation.

* The first tab, as its name implies, deals with the GPS satellites
(Figure 2-23).

e

pin|lock| use| pinllock use| p pin|lock| use|
iV S¥F 1TV 3BV F
P2 T2 T T 2 R =1 i 2=l i
iV v 1M YV 2V
iV 12F W AN ¥ BN ¥
iV v 1KV 21V ¥ 28 ¥
EV v HWF V¥ 2F ¥ NIV ¥
A T T 1< 2 < N a1 T
3 I T - 2 ) N R 7 ol
Alltalock | Nonetolock] Allto use | None to use|

Figure 2-23. GPS Tab
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The tab displays three columns, prn, lock and use, which are
described in Table 2-5.

Table 2-5. Description of Data Displayed in the GPS Tab

Notation

Meaning

prn

GPS satellites’ pseudo-random noise code numbers.

lock

Checkmarks in this column indicate that the corresponding satel-
lites are enabled for tracking. As shown in Figure 2-23, GPS satel-
lite PRN 8 is disabled for tracking.

use

Checkmarks in this column indicate that the corresponding satel-
lites are enabled for position computation. In Figure 2-23, GPS sat-
ellite PRN 4 is disabled for position computation.
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Use the All to lock and All to use buttons to select all GPS satellites
at one time.

Use the None to lock and None to use buttons to deselect all GPS
satellites at one time.

The second tab, as its name implies, deals with the GLONASS
satellites (Figure 2-24).

Satelite Numberin
& Frequency Channel Mumber ¢ Slot Number

fen|lock| use| fen|lock| use| fen/lock

| fenllock use|

1Pk TRF B F 8F @
2P F BRRF MR F AR R
i F iRk BEF 2F W
1P F WERF BFF 2F R
SR P NRERF TP F #BFF
CR A RN T il e ol

Alltolock | Nonstolock] Alltause | None to uss|

Figure 2-24. GLONASS Tab

Satellite Numbering

For user convenience, GLONASS satellites can be displayed
ordered either by their Frequency Channel Number or by the Slot
Number.
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The tab displays three columns, fen/sat, lock and use, which are
described in Table 2-6.

Table 2-6. Description of Data Displayed in the GLONASS Tab

Notation

Meaning

fen/sat

GLONASS satellites” frequency channel numbers, if the Fre-
quency Channel Number checkbox is selected. GLONASS
satellites’ slot numbers, if the Slot Number checkbox is
enabled.

lock

Enable GLONASS satellites for tracking.

use

Use this GLONASS satellite for position computation.

Use the All to lock and All to use buttons to select all GLONASS
satellites at one time.

Use the None to lock and None to use buttons to deselect all
GLONASS satellites at one time.

The third tab, as its name implies, deals with the WAAS/EGNOS
satellites (Figure 2-25).

NS
W Chammell
setwiaas: |10 7 asGPs: [12 %

Interpret message #0 as message : & |0 3-

Use lono Corrections © ¢ Mever ¢ Ifexist & Only
[ ¥ Channel

Setwiaas: [122 3] asGRs: [ 3]
Interpret message #0 as message : & |0 3-

Use lono Corrections © ¢ Mever ¢ Ifexist & Only

[™ Enable output of "'true" WaAS PRM numbers

Figure 2-25. WAAS Tab

A WAAS-enabled JNS receiver allows simultaneous tracking of
two WAAS satellites. Either of the WAAS satellites is allocated its
own channel. Below it will be shown how to set up Channel 1
(Channel 2 is handled in the same manner).

The Channel 1 checkbox, if selected, allows you to specify
necessary settings for the desired WAAS satellite signal reception.
One uses the Set WAAS and as GPS spin-boxes to associate the

selected WAAS PRN (120-138)! with an appropriate GPS PRN (1-
32). It is recommended to select for this purpose one of the GPS

1. WAAS satellites with PRNs 122 and 134. EGNOS satellites with PRNs 120 and 131.

www.javad.com
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PRNs that are not used in the current GPS constellation. At writing
this manual, the unused GPS PRNs are: 12 and 32.
* The Interpret message #0 as message: # spin-box disables
message 0.
* The Use Iono Corrections radio button group allows the user to set
the desired ionosphere correction mode.
—Never. Ignore any iono corrections received from the WAAS
satellite(s).
—If exist. All acquired satellites will be used in position
computation, (i.e., even the satellites whose WAAS Iono
Corrections are unavailable).
—Only. Only satellites whose WAAS Iono Corrections are
available will be used in position computation. Note that this is
the default option for the radio button group.
If the Enable output of ''true' WAAS PRN numbers checkbox is
selected, the WAAS satellites will have their true WAAS PRNs (not
"GPS associated") in the corresponding Satellite Indices messages.

Base Tab

With the Base tab, the user can configure the receiver for use as a reference
station (Figure 2-26).

Receiver Configuration
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Figure 2-26. Base Tab
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Base Station Coordinates (Antenna Phase Center)

As the names of the GPS/GLO at one time and GPS/GLO separately
radio buttons imply, these allow the user to specify for GPS and GLONASS
either common reference coordinates or individual reference coordinates. In
most cases it is recommended to use the same reference coordinates both for
GPS and GLONASS. After the user has selected GPS/GLO separately, he/
she will see the GLONASS tab appear on the screen too.

In the Reference Geodetic Coordinates area the user enters the geodetic
coordinates of the base antenna’s phase center.

* Lat — Antenna latitude in degrees, minutes, and seconds format with a
hemisphere letter (N or S).

* Lon — Antenna longitude in degrees, minutes, and seconds format with
a hemisphere letter (E or W).

* Alt — Antenna height above the ellipsoid, in meters.

The reference geodetic coordinates specified in this tab will
relate to the antenna L1 phase center. To account for the offset
between the L1 and L2 antenna phase centers, use the
parameter L1 to L2 Antenna Phase Center offsets.

If the coordinates entered are expressed in a datum other than
WGS 84, which is default, ensure that the correct datum ID is
selected.

There are three ways to enter the coordinates:

1. Type in the precise latitude/longitude and ell. height manually (use the
Lat, Lon and Alt edit boxes).

2. Use the absolute coordinates averaged over the specified time interval
(with the Averaged and Avg.Span controls).

For this, enable Averaged and enter the Averaged Span in seconds,
then click Apply and OK. Click Tools->Reset receiver and wait until
the specified interval (span) completes. Examine the Base coordinates
on the Base tab, they should correspond to the coordinates obtained
from the average. Click Refresh if the coordinates are zeros.

3. Use the instant absolute coordinates from the receiver (by pressing the
Get from receiver button).

Pressing the Datum Parameters button will open the <Datum ID> Datum
Parameters window that is similar to Figure 2-22 on page 2-37).
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Notice: Do not confuse the described window and that shown in
Figure 2-22 on page 2-37. Although their purposes and
structures are similar, they affect different coordinates.

Notice: With the controls in the <Datum ID> Datum Parameters window
shown on page 2-37 you instruct the receiver to output the
currently computed position in the selected datum. Whereas
with this window you only define the datum in which the base
station’s coordinates will be expresseqd.

L1 to L2 Antenna Phase Center offsets

Use these fields if you need to account for the difference between the L1
and L2 antenna phase offsets.

RTCM Settings

The Station ID edit box allows the user to assign a separate station ID to
each reference station working in the area. On the rover side, this ID allows
easy identification of the reference station whose RTCM messages are
being received by the rover receiver. This ID must be an integer from 0
(default) to 1023.

With the Max. number of Satellites edit box, the user specifies the
maximum number of satellites allowed for use in RTCM messages types 18
through 21. A 0 means that all of the available satellites will be included in
the above mentioned RTCM message types. If an RTK system has a slow
modem (the baud rate is less than 9600 bps), it is recommended to restrict
the number of satellites included in these messages. The limitation allows
the user to reduce the amount of data sent by the base station, which helps to
avoid the data link overload. If the actual number of satellites in sight
exceeds the value entered in this edit box, the RTCM messages will include
data only from the satellites with higher elevations and the number of
satellites included in the RTCM messages will not be greater than that
specified in the edit box.

The Health list box is intended to define the reference station status:
* Good — station is operating normally.
* Bad - station is not working normally.

¢ Unknown — station health status is unknown.

With the Measurements Sent radio buttons, the user specifies the
measurement types that will be included into the RTCM message types 18
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through 21. Currently, the mentioned RTCM messages always contain C/A
measurements. The user can also include either or both P/L1 data and P/L2
data in these messages (on condition that the JNS receiver is configured as a
dual-frequency unit).

The GPS and GLONASS checkboxes, which are grouped together within
the System Used area, indicate the satellite constellations included in the
RTCM message types 18, 19, 20 and 21.

If the Pseudo-range smoothing checkbox is selected, the receiver will use
smoothed pseudoranges in the RTCM message types 19 through 21.

CMR Settings

With the Station ID the user can specify the base station ID, which will be
included into the CMR messages transmitted by this base station. On the
rover side, this ID allows easy identification of the reference station whose
CMR messages are being received by the rover receiver. This ID must be an
integer from O (default) to 31.

The Motion list box characterizes the motion of the reference station:
¢ Unknown — the motion state is undetermined.
¢ Static — the receiver is motionless.

¢ Kinematic — the receiver is in motion.

Use the Short ID, COGO and Long ID to include the reference station's
point feature code! into CMR message type 2.

The CA/L1, P/L1 radio buttons and the P/L2 checkbox, which are grouped
within the Measurements Sent area, allow the user to specify which
measurement types will be included into the corresponding CMR messages
broadcasted by the reference station. If the receiver is a single-frequency
unit, the P/LL1 and P/L2 controls will not be available.

The GLONASS message spin box allows the user to specify which
message types will be associated with GLONASS measurements. You can
choose any unused message types between 3 and 7.

Click the Configuration of Receiver Ports button to go to the Ports tab.
For a description of this tab, refer to “Ports Tab” on page 2-50.

1. Feature code is an alphanumeric code used to describe an object to be surveyed.
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Rover Tab

In this tab, the user can configure a receiver as a rover station (Figure 2-27).
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Figure 2-27. Rover Tab
Positioning Mode

These four radio buttons are included in the Rover tab only for user
convenience. They mirror the same named buttons from the Positioning tab.
For more information about this radio button group, see ‘“Positioning Tab”
on page 2-34.

DGPS Parameters

To switch a roving receiver to Multi-base mode, select the Multi-base

checkbox. In this mode, the rover is able to use differential corrections
received from more than one reference station'.
* Correction usage

If the user selects the Nearest checkbox, the rover will use differential
corrections transmitted by the nearest reference station.

Notice: When working in the Nearest mode, make sure that the Mix and

Best checkboxes are clear.

1. Currently, this mode allows the rover to use up to five reference stations simultaneously.
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The Mix checkbox allows the user to run the rover station in average
mode.

When the rover runs in this mode, the Best checkbox must be
unselected.

With the Corrections and Positions radio buttons, the user
specifies which of the averaging modes will be used for position
computation.

—If both the Mix checkbox and Corrections radio button are
selected, the rover will be averaging differential corrections
received from different reference stations.

—If the user selects the Mix checkbox and Positions radio button,
the receiver will average the computed positions, not the received
corrections.

If the Best checkbox is selected, the receiver will use differential
corrections that correspond to the most precise of the obtained position
estimates. Best means that the solution has the least RMS error.

In the CD Corrections max. age edit box, the user can set the maximum
age (in seconds) of the code differential corrections used for position
computation. It must be an integer value between 1 and 1200. The default is
30. If the age of the corrections exceeds the value specified in this edit box,
the rover will compute a stand-alone position.

Use the Iono Corrections max. age edit box to specify the maximum age
(in seconds) of the ionosphere corrections used for position computation.

If you set the Use Iono Corrections checkbox to on, the rover receiver will
use in position computation both the ionosphere corrections from RTCM
message type 15 and differential corrections from RTCM message types 1
and 31 (or 9 and 34).

The Source list box serves to specify the source (port) from which the
receiver will use differential corrections for position computation.Notice:

The receiver uses this parameter only if Multi-base mode is
unchecked.
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Enable Solutions

These four checkboxes are included in the Rover tab only for user
convenience. They mirror the same named checkboxes from the
Positioning tab. For details, refer to “Positioning Tab” on page 2-34.

Notice: At the present time, the RTK Float and RTK Fixed checkboxes
are unavailable and checked at the same time demonstrating
that these solution types are also enabled.

RTK Parameters

The RTK mode radio button group serves to toggle between the
extrapolation and delay modes. If Extrapolation is selected, the rover will
extrapolate the base station's carrier phase measurements when computing
the rover's current RTK position. If Delay is selected, the rover will not
extrapolate the base station's carrier phase measurements to compute the
current rover position. Instead, the RTK engine will compute either a
delayed RTK position (for the epoch to which the newly received RTCM/
CMR message corresponds) or the current stand-alone position (while
waiting for new RTCM/CMR messages coming from the base).

To define the rover dynamics, use the Dynamics radio button group.

The Ambiguity fixing level radio buttons govern the process of the RTK
engine fixing integer ambiguities. The RTK engine uses the ambiguity fix
indicator when making a decision whether to fix ambiguities or not. Low,
Medium and High correspond to the indicator's 95%, 99.5% and 99.9%
states, respectively. The higher the specified confidence level, the longer the
integer ambiguity search time. This is the price one pays for the higher
reliability of the ambiguity fixed solution.

The Measurements Used checkbox group allows the user to select
measurement types used by the rover for position computation.

In the Base Corrections period edit box, the user can set the differential
correction update interval. It should be noted here that for a proper rover
setup in RTK Delay mode the user should know the exact rate at which the
reference station broadcasts its differential correction data.

Notice: The receiver will use the Base Corrections period control only if it
runs in Delay mode. Also, this edit box is used to provide more
reliable synchronization between the base station and rover.
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If you set the Use old ref. coordinates checkbox to on and then launch
RTK, the rover receiver immediately starts using the existing reference
coordinates in place of expecting when the reference station transmits some
updated reference coordinates to the rover side.

Care should be taken when setting this parameter to on. Imagine
for a moment that the rover has changed the location and
started a new RTK session with a different reference station.
Should this parameter be set to on, the rover receiver will be
misusing the old reference coordinates for some time, which will
most likely result in position blunders until the rover receives a
first message with the correct reference coordinates.

The Source list box serves to specify the source (port) from which the
receiver will use differential data for position computation in RTK mode.

With the GLONASS message spin box the user assigns the message type
for GLONASS measurements. Make sure that both the reference station and
rover receiver use the same message type for GLONASS measurement data.
This parameter is applicable only if you use CMR differential messages.

Press the Reset RTK Engine button to reset the RTK engine. It means that
all of the previously obtained estimates (estimated position, variance-
covariance matrix, etc.) will be thrown away and the RTK engine will then
start from scratch.

To access the tab allowing you to revise and edit port settings, either click
the Ports tab, or press the Configuration of Receiver Ports button.
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Ports Tab

The Ports tab, as shown in Figure 2-28, comprises six different sections that
are reached via the six subtabs.

2. Receiver Configuration
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Figure 2-28. Ports Tab

These subtabs are as follows:

Serial

Serial — Used to specify the data the receiver serial ports will transmit/
receive. See “Serial” on page 2-50.

Parallel — Used to specify the data the receiver parallel port will
transmit/receive. See “Parallel” on page 2-52.

Modem - Used for configuration the Lexon and Prego receivers’
internal radio modem. For all other receiver models, the settings on this
subtab will be unavailable. See “Modem” on page 2-53.

USB - Used to specify the data the receiver USB port will transmit/
receive. See “USB” on page 2-53.

Ethernet — Used to configure the Ethernet, Telnet, and FTP
communication settings. See “Ethernet” on page 2-54.

TCP — Used to specify the data the receiver will transmit/receive over
TCP/IP network. See “TCP” on page 2-56.

Use this subtab to adjust the settings for serial ports A, B, C and D
(Figure 2-28 on page 2-50).
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The Input list box allows the user to specify what type of data to input
on the selected port.

None — The port will reject any incoming data.

Command — The port is in command mode. In this mode the port
will recognize the commands sent by the user.

Echo — The port is in echo mode. Being used in this mode the
receiver port redirects all incoming data to an output stream. Output
stream may be either a port or the current log file.

RTCM 2.x — In this mode, the receiver recognizes and decodes the
RTCM version 2.1, 2.2, and 2.3 messages accepted on the
corresponding port.

RTCM 3.x — In this mode, the receiver recognizes and decodes the
RTCM version 3.0 messages accepted on the corresponding port.

CMR - The port is in Compact Measurement Record (CMR)
messages input mode.

The Output list box allows the user to specify what type of data to
output on the selected port.

None — The port outputs nothing.

DGPS RTCM {1,31} — The port outputs RTCM message types 1,
31.

DGPS RTCM (9,34} — The port outputs RTCM message types 9,
34.

RTK RTCM {18,19,22,3} — The port outputs RTCM message types
18, 19, 22, and 3.

RTK CMR {10,0,1} — The port outputs CMR message types 10, 0,
1.

User Defined — The port outputs data specified by the user. It means
that the user defined an arbitrary message set that will be outputted
through the port.

In the Period edit box the user sets the message output interval (in
seconds).

It is worth noting, however, that the period of RTCM messages
types 22, 3 and CMR message type 1 cannot be changed with
this edit box. The default period for the mentioned messages is
10 seconds. If the user wants to change the period, he/she
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should use the em command from the Manual Mode window. For
more details on em refer to the GRIL Reference Manual.

Notice: If the user sets an incorrect message output interval (the Period
edit box), PCView will run a utility called Output Period Setup
Wizard. For more information on the Wizard, see Appendix C on
page C-1.

To set the baud rate for the corresponding receiver port, use the Baud

rate list box.

The checkbox RTS/CTS enables/disables hardware handshaking for
the port.

In addition to described settings, port D has a unique checkbox
Infrared that permits the user to utilize this port for infrared connection
with an external device.

Use Infrared mode only if the following conditions are met:

* A device you are going to connect to is compatible with the receiver
infrared interface (for example, CDU-1).

* Your receiver supports the infrared port hardware-wise.

* The Infrared Port option is enabled in your receiver.

Parallel

The settings represented on this subtab are similar to those in the Serial
subtab except that these settings are intended for managing parallel port
(Figure 2-29). For detailed information on each setting, refer to “Serial”
on page 2-50.

]
[ipuat ; |Command 'l
Output ; lNone 'i Period [sec]:I

Figure 2-29. Parallel Subtab

Parallel
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Modem

Notice: These settings are only available if you have the Lexon or Prego
receiver with the internal Spread Spectrum modem. Otherwise
the settings will be grayed out (Figure 2-30).

[rtrerial it I ;I [lirj= I vi Artenrad b L Bt

ifejsl=1y) Ditout I .!
e iz | 7] Foper € Hone® Low
Beritd (sec] |

Figure 2-30. Modem Subtab

Internal Modem

Input, Output and Period are similar in their purposes to the
analogous settings in the Serial and Parallel subtabs.

The Type list box allows the user to set operation modes (Receiving or
Transmitting).

The Mode list box intends to specify the method used to transmit data:
* Off — internal modem is turned off.

* FHSS - internal modem uses frequency-hopping spread spectrum
technique.

* DSS - internal modem uses direct-sequence spread spectrum
technique.

With the Antenna radio buttons, the user sets the antenna type the
modem uses.

¢ Int — stands for an internal antenna.
¢ Ext — stands for an external antenna.

The user can set power transmitting mode for the internal modem using the
Power radio buttons.

USB

This subtab contains settings that allow the user to specify what type of
data to input/output on the USB port (Figure 2-31). These settings are
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the same as those in the Serial subtab. For more information, refer to
“Serial” on page 2-50.

Senal ] F'aralle|| todem USE lEthernet] TCR ]

USBE Inpuat - |C0mmand j Clutpuat : |N0ne LJ Perind [s] :

Figure 2-31. USB Subtab

Ethernet

Notice: The settings on this subtab are only available if a connected
receiver has the Ethernet capability.

Figure 2-32 shows an example of the Ethernet subtab.

2 Receiver Configuration

General | MinPad | Pasitioning | Base | Rover £Paits || Events | Advanced |
Serial | Parsllel | Modem | USE  Ethemet | TCP |

Warning. Mewly applied settings will be activated only after receiver reset.

IF Settings Telnet Settings FTF Settings
IF sddress:  [192.168.0.100 TCP Fort: 6002 TCP Port. 21
IF Mask: 255.256.266.0 Timeout (s): |00 Timeout [s):  |600

Gateway: 192.168.0.1

Metwark Password. |

Refresh

0K Exit | Save | Setallparameters to defaults |

Figure 2-32. Ethernet Subtab

IP Settings
With the settings in this group, the user specifies the IP addressing
parameters for a connected receiver.

e IP Address — A unique identifier for your receiver on a TCP/IP
network. An IP address comprises four numbers from 0 to 255,
separated by periods. The receiver’s default IP address is
192.168.2.2.

* [P Mask — Mask used to determine what subnet the receiver belongs
to. The default mask is 255.255.255.192.

* Gateway — An IP address for the gateway used to communicate with
the devices on another network. The default gateway is 192.168.2.1.

2-54 PCView Software Manual www.javad.com



Notice:

Notice:

Notice:

Notice:

www.javad.com

LEARN PCVIEW IN DETAIL

Receiver Configuration Window

Contact your system administrator if you are not sure what
settings are safe to use.

Telnet Settings

These settings allows the user to configure a connected receiver to act as
a telnet server. Remote devices (felnet clients) can then connect to the
telnet server over a TCP/IP network and control the server behavior as if
it was a direct connection. Currently up to 5 simultaneous telnet clients
can be connected to the telnet server.

* TCP Port — This is a TCP/IP port a telnet server listens on for the
connection. The default port number is 8002.

* Timeout — This parameter sets the amount of time in seconds the
telnet server allows an inactive connection to remain open. After
this time, the server terminates the unused connection. The default
timeout is 600 seconds.

Contact your system administrator if you are not sure what
settings are safe to use.

FTP Settings

These settings allows the user to configure a connected receiver to act as
an FTP server. A remote device (an FTP client) can then connect to the
FTP server over a TCP/IP network and download raw data files. Only
one simultaneous FTP connection is supported.

e TCP Port — This is a TCP/IP port an FTP server listens on for
connection requests. The default port number is 21.
* Timeout — A period of time in seconds that must elapse before an

inactive connection will be terminated. The default timeout is 600
seconds.

Contact your system administrator if you are not sure what
settings are safe to use.

Network Password

This is a password used in Telnet and FTP. The Telnet or FTP client
must enter password to access the Telnet or FTP server. You can enter
up to 15 alphanumeric characters.

To activate any configuration change, you should click Apply,
then OK and then reset the receiver using the Reset receiver
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action in PCView or pressing and holding the receiver’s Reset
button for about one second.

TCP

Notice: The settings on this subtab are only available if a connected
receiver has the Ethernet capability.

With this subtab the user specifies what type of data to input/output over
the corresponding TCP/IP stream (Figure 2-33 on page 2-56). These
settings are the same as those in the Serial subtab. For more
information, refer to “Serial” on page 2-50.

2. Receiver Configuration

General | MinPad | Positioring | Base | Rover Parts | Events | advanced |
Seriel | Paralel | Modem | USB | Ethernet TCP |
TOPA  Input [Command ~| Outpur: [FERE | Peindis:|
TCPB  Input [Command | Output: [None | Peindig:|
TCPC Input: ]Command ﬂ Output: |None ﬂ Period [5]: ,—
TCPD  Input [Command ~| Output: [None | Peindis:[
TCPE  Input [Command | Output: [None | Peindig:|

Refresh
[CoK ] Esit | Save | Set ol parometers to defoults |

Figure 2-33. TCP Subtab
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This tab is used to review and configure the 1PPS signal and Event marker
settings (Figure 2-34).

“ JPS Receiver Configuration

Generali tinPad I Pnsitinningl Base i F!nveri Ports ;) 3 dvancedl

¥ PPS & Enabled v PPS B Enabled

Edg dgf
Period, I1DDD [m=] & Rise Fal Period: (1000 [mz] & Bise ¢ Fal

Offzet: IU (1 e — Offset: |0 Ml pof Tim
Offzet: IU [mg] T GPS & UTCus Offset: |0 [rs) €GPS & UTCus
Period of 'marked" pulses : C GLO C UTCsu

Period of 'marked’ pulses € GLO C UTCsu
[o M) 7 Tied with Fef. Time 0 M) [Z Tied with Fief. Time

¥ Ewvent & Enabled

T EventB Enabled

Edge il Edge—
1 Llock Synchronization & Rise  Fal [y}~ e [ e g = L e & Hiee Fa =

Status : Ic-

Hepeat Spnchionization

Statis I-.--‘f

Hepeat Syrichidnization

rRef. Time—— Ref. Time———

i GPS & UTCus
¢ GLO ¢ UTCsu

Ca R e e

’7(" GES = e

IV Tied with Ref. Time [ Tied with HER e

Fefresh | e |

| Ok, I Exit | Save ISelallparamelersludefaultl

Figure 2-34. Events Tab

The PPS A Enabled and PPS B Enabled checkboxes enable the
receiver to generate 1PPS signals and also allows the user to modify the
settings related to the selected 1PPS signal.

The Period edit box determines the rate of generating the 1PPS signals
via the corresponding output connector.

The user can determine millisecond and nanosecond parts of PPS signal
offsets with respect to the selected reference time grid using the Offset
(ms) edit box for millisecond part and Offset (ns) for nanosecond part.

With the Period of 'marked' pulses edit box, the user specifies the
period of the marked 1PPS signal.

Using the Edge radio button group, the user synchronizes the edge
(rising or falling) of the 1PPS signal with the specified reference time.

The Ref. Time radio button group allows the user to select the reference
time that the 1PPS signal will be synchronized with. There are four
available reference time scales:

* GPS means GPS system time.
* GLO means GLONASS system time.
e UTCus means UTC(USNO).
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e UTCsu means UTC(SU).

If the user selected the Tied with Ref. Time checkbox, the receiver will
synchronize the 1PPS signal with the chosen reference time. Otherwise,
1PPS will be synchronized either with the receiver's internal clock or
with an external reference frequency applied to the receiver (in the latter
case the Source setting described on page 2-63 must be set to External).

In order to enable or adjust the event input function, use the controls
described below.

The Event A Enabled and Event B Enabled checkboxes, if selected,
allow the receiver to measure and log event times in the specified
reference time with high accuracy.

If the Clock Synchronization checkboxes are selected, the receiver
executes a one-time synchronization of its one-millisecond cycle grid
with the corresponding edge of the event signal.

The Status indicator shows whether the receiver clock is actually being
synchronized with the event signals or not. If you see on in the field, it
means the synchronization has been done successfully.

In some cases, however, it can be necessary to perform the
synchronization again. For this purpose click the Repeat
Synchronization button several times until on appears.

The Rise and Fall radio buttons serve to measure the time of either the
rising edge or falling edge of the input event signal.

The Ref. Time radio button group sets the reference time scale that the
event reception time will be synchronized with.

With the Tied with Ref. Time checkboxes, the receiver is instructed to
measure the event reception time in the selected reference time with or
without consideration for the computed receiver clock offset.
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Advanced Tab

The Advanced tab is composed of six subtabs, as illustrated in Figure 2-35.

/% Receiver Configuration "

Ganerall MlnF‘adl F'ns\hnnlngl Base I anarl Ports I Events Advanced I

Anti-lntarference! Multipath Reduction  Loop Management | Esternal Flequencyl Raw Data Managementl Dptionsl

PLL bandwidth: [50 iHe [ Ensblz Commen Tracking loop]
l [T Static Mode
PLL order: 3
e e Banduwidth of individual PLL: 20 [Hz)
uided loop bandwidth: i H

LK) Bandwidth of common PLL: 250 [Hz]
C/f code guided loop bandwidth: 08 Hz]
¥ Enable Adaptive Guided Loops v Enable Common Loap for L2

¥ Enable P/L1 and PAL2 tracking

Refresh I Appl I

Ok, I E=it Save | Set all parameters to defaultsl

Figure 2-35. Advanced Tab

WARNING: Only change these advanced settings when it is known what they
mean. Unsuitable changes to these subtabs can cause the receiver
to run improperly. If you are doubtful of any changes you made to
these subtabs, click the Set all parameters to defaults button to get
the factory default settings back. For a description of these
subtabs refer to the corresponding paragraphs below.

Anti-Interference

With the Anti-Interference radio button group (Figure 2-35 on page 2-
59), the user enables mode allowing the JNS receivers to suppress the
impact of narrow-band interferences.

The user can assess the presence of interference based on the following
information:

* When the number of tracked satellites is fewer (by 2 or greater) than
the number of satellites in view.

* When the signal-to-noise ratio (C/NO) in the C/A channel for the
satellites having elevations above 30 degrees does not exceed 40
dB/Hz.

* When the information about interferences indicates that Jamming
Suppressor detected interference signals within the specified band

www.javad.com PCView Software Manual 2-59



LEARN PCVIEW IN DETAIL
Advanced Tab

and also the strength of aggregate in-band interference is
characterized as high or hard. This information you can obtain with
the command em, , jps/Jl.

Multipath Reduction

The checkboxes Code multipath reduction and Carrier multipath
reduction are used for mitigation of the multipath phenomenon
(Figure 2-36).

Anti-lnteference  Multipath Feduction i

I Ccde multipath reduction
I~ Camier multipath reduction

Figure 2-36. Multipath Reduction Tab

When the reference station and rover station run in DGPS mode and
they are not free from the impact of multipath, we recommend that you
select the Code multipath reduction checkbox for both the reference
and rover stations.

Notice: If you use a pair of receivers in RTK mode, you can additionally
select the checkbox Carrier multipath reduction for both
receivers.

Loop Management

In this subtab the user can configure the settings that deal with the
receiver capability of searching, acquiring and tracking the GPS+
satellite signals (Figure 2-37 on page 2-61).

WARNING: Care should be taken when changing the settings for this subtab.
JNS recommends that users do not change these settings without
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good reason. For an explanation of this subtab, please see details
under Figure 2-37 on page 2-61.

,{':Q?_Receiver Configuration o 5[
Genelall M\nF'adI F‘ositioningl Base | F!over' Parts I Events Advanced I
Amli-\mlerfarencai tultipath Feduction  Loop Management IExtama\ Frequencyl Raw Data Managementl Dnliomsl
PLL bandwidths [z50 g (el B e e e e
PLL order |_3 ™ Static Mode
i | Bandwidth of individual PLL: 50 [Hz]
vided loop bandwadth: - H
8| Bt of common FLL [0 Hz)
C/& code guided loop bandwidth: 0.8 [Hz]
¥ Enable Adaptive Guided Loops [V Enable Comman Loap for L2
¥ Enable P/L1 and P/L2 tracking
Refresh Apply I
(1] I Exit I Save I Set all parameters to defaults

Figure 2-37. Loop Management Tab

The PLL bandwidth edit box governs the noise bandwidth of the
guiding phase lock loops. In this box, you can enter values between 2
and 50 Hz.

With the PLL order edit box, the user can toggle guiding and common
lock loop order between 2 and 3. Care should be taken when using a
2nd order PLL because this can adversely affect satellite signal tracking
in some cases.

The Guided loop bandwidth edit box governs all of the guided loops
but the C/A DLLs. Here the user can enter values between 0.1 Hz and
10 Hz.

The C/A code guided loop bandwidth edit box specifies the
bandwidth of the receiver's C/A group delay lock loop. In this box, one
can enter the values between 0.1 Hz and 50 Hz.

With the Enable Adaptive Guided Loops checkbox, the user enables/
disables the use of adaptive guided loops. If the user selects the
checkbox, the receiver will adjust the guided loops bandwidths
depending on the actual strengths of the signals tracked. The weaker the
signals, the narrower the bandwidths.

With the Enable P/L1 and P/L2 tracking checkbox the user can adjust
tracking settings for the receiver. If one has either a single-frequency
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receiver or L1 only antenna, it is recommended to disable tracking of
the P/L.1 and P/L2 signals.

By selecting the Enable Common tracking checkbox, you will enable
this mode and make the other controls in the group available for
modifying. Common tracking mode is used to considerably improve the
tracking characteristics of JNS receivers in hostile environments.

* When the receiver is in Common tracking mode, one can enable the
Static Mode checkbox. This mode allows the receiver to acquire
satellites with lower signal-to-noise ratios and reduce the
reacquisition time for the satellite signals after a temporary loss of
lock.

Notice: Enable the Static Mode parameter only if the receiver antenna is
completely stationary. If your receiver antenna may have some
movement, even for a few millimeters, disable the Static Mode
parameter. Moving the antenna while in Static Mode may result
in a loss of lock to satellites.

* The Bandwidth of individual PLL and Bandwidth of common
PLL edit boxes mean exactly what their names imply.

Select the Enable L2 common loop checkbox to avoid the loss of 1.2
phase tracking in dynamic applications due to antenna rotation around
its axis.

External Frequency

The settings on this subtab, allow the operator to configure the use of
reference frequency (Figure 2-38 on page 2-63). It may be either a high-
stability external frequency or the receiver's internal crystal oscillator.
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% Receiver Configuration

Anti-\nlerfalﬁncel Multipath Heducliunl Loop Management  External Frequency I Faw D ata Management I DptiDnsI

Genarali MinPad I Positioningl Baze I anerl Forts i Events ;¢

— Frequency Source
— Source ‘

= Intemal " External

— Externd Frequency Source Parametsrs

Ext- frequencywvalue [MHz]

I 10
Ext frequency souroe stafis I-.-N
|._.|:

Ext freq: signal ampituds

i Dscillator Offset Reduction
= Off
" Freq. Locked
" Freq. and Time Locked

Riefiash Aoply I

(0] I Exit I Save I SetallparameterstodefaullsI

Figure 2-38. External Frequency Tab
With the controls in the Source group, the user specifies the reference
frequency input that the receiver will use:
* Internal — means the receiver uses the internal oscillator.

» External — means the receiver uses an external frequency.

Notice: By switching from Internal to External and vice versa may result
in a temporary loss of lock to satellites.

External Frequency Source Parameters

With the Ext. frequency value edit box the user specifies nominal
external frequency value. Here the user can enter the integer values
between 2 and 40 MHz. The default value is 10 MHz.

The Ext. frequency source status field shows whether the external
frequency is being used or not:

* off — Indicates that the receiver is using the internal crystal
oscillator.

* wait — Indicates that the receiver is waiting for the external
frequency lock. More precisely, this value will be returned in the
following three cases:

—If the external frequency oscillator is disconnected

—If the amplitude of input signal is too low
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—If the actual external frequency is different from that specified in
the Ext. frequency value edit box

* locked — Indicates that the receiver is using the external frequency.

With the Ext. freq. signal amplitude field the user can estimate the
external frequency signal amplitude:

* off — Indicates that the internal oscillator is actually being used.

* low — Indicates that the external frequency signal's amplitude is
lower than needed.

» ok — Indicates that the external frequency signal's amplitude meets
the specs.

The Oscillator Offset Reduction group box allows the user to govern
the behavior of the internal crystal oscillator.

e The Off radio button means that the oscillator frequency offset
reduction mode is turned off.

* The Freq. Locked radio button means that the receiver will adjust
the internal oscillator's frequency until the measured frequency
offset is reduced to zero. By using the incoming satellite signals, the
receiver will force the internal oscillator to generate a very stable 20
MHz frequency signal. This frequency output is available via the
corresponding receiver output pin.

Tip:  The user is able to monitor the offset reduction in the
Clock offset field of the GEO tab. After selecting
Freq. Locked the value in Clock offset starts to
reduce and soon (usually in a few minutes) it will
become equal to zero, while in contrast Osc. Offset
will not change much.

* The Freq. and Time Locked radio button means that the receiver
will adjust both the internal oscillator's frequency until the
measured frequency offset is reduced to zero and the internal clock
until it gets fully synchronized with the specified reference time
scale.

Notice: Switching from Freq. Locked or Freq. and Time Locked to Off
may result in a temporary loss of lock to satellites.

Freq. Locked guarantees that the receiver's 20 MHz output will have
long-term stability, not necessarily short-term stability. However, there
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is a way to assure that both of these characteristics will be good enough.
It can be done by selecting Enable Common tracking on the Loops
Management subtab.

Raw Data Management

This subtab, which is shown in Figure 2-39, contains the controls for
specifying the frequency at which the receiver will update raw
measurement and position. Also, the user may set up the controls that
affect the signal processing.

% Receiver Configuration

Generall MinFad I F'Usiliuningl Base i F!Uverl Ports I Ewvent:

Anti-lntarferencal Multipath Heduction| Loop Managementl Extemal Frequency  Raw Data Management | Dplionsl

— Raw Measurement Update Rate

UpdiieEare: 100 (]
Current Lpdate Rate : 100 ms)

— Position Ipdate Rate

Update Fate : 100 ms)
Current Update Mate : 100 | ‘sl

Code smocthing interval : 50 (=)

Doppler srroothing method : |2
Mominal lano smoothing intersal : ISD [z)

Minirmumn lcno smoothing interval : |3D [z) Refiesh I Aoply

0K I Exit I Save I Set all parameters to defaults
I

Figure 2-39. Raw Data Management Tab

The Raw Measurement Update Rate group allows the user to
determine the raw data update period. In the Update Rate edit box,
enter a value (in milliseconds) to specify the period. With Current
Update Rate, the user can check which period is actually being used by
the receiver.

The Position Update Rate group allows the user to determine the
receive position update period. In the Update Rate edit box, enter a
value (in milliseconds) to specify the period. With Current Update
Rate, the user can check which period is actually being used by the
receiver.

The Code smoothing interval edit box specifies the interval over which
pseudoranges are smoothed by using corresponding carrier phase
measurements. Here you can enter values between 0 and 900 seconds.
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Zero designates that carrier phase measurements will not be used for
smoothing pseudo-ranges.

In the Doppler smoothing method edit box, the user sets the method
used for smoothing Doppler. There are three available methods:

* Receiver outputs raw (unsmoothed) Doppler. Instantaneous yet
rather noisy Doppler measurements.

* Doppler is computed using two consecutive carrier phase
measurements, CarPhase[i] and CarPhase[i-1], where i stands for
the current epoch. Such Doppler measurements are less noisy than
in the first case.

* Doppler is computed using three consecutive carrier phase
measurements, CarPhase[i], CarPhase[i-1] and CarPhase[i-2],
where i stands for the current epoch. Doppler measurements
obtained in this mode are least noisy.

With Nominal Iono smoothing interval edit box, the user specifies the
nominal ionospheric correction smoothing interval over which raw
ionospheric corrections are smoothed (assuming the receiver has been
working for some time and has already obtained enough raw
ionospheric corrections to perform such smoothing). This integer
parameter varies between 0...900 seconds. The default value is 60.

With the Minimum Iono smoothing interval edit box, the user
specifies the minimum smoothing interval for the receiver to filter raw
ionospheric corrections before they can be used in position
computation. This integer parameter ranges between 0 and 900 seconds.
The default value is 30 seconds.

Options
Figure 2-40 on page 2-67 shows the subtab from which the user can
turn on/off the Cinderella option. Every other Tuesday, Cinderella
enables the receiver to run as a dual-frequency GPS+GLONASS unit
during 24 hours. For information on scheduling Cinderella Tuesdays,
visit the Cinderella Option page on the JNS web site at http://
www.javad.com
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. Receiver Configuration

Genera\] MlnF'ad1 Poslllon\ng1 Base ] F\over] Ports ] Events Advancedi

Antirlnterferenca] ultipath Fieduct\on] Loop Management] External Fraquencﬂ Raw Data Managemert  Options ]

~Cinderella—
&  of

Figure 2-40. Options Tab
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Site Configuration Window

This window allows the user to enter an antenna-specific information for the
site to be measured. The settings you defined on this page will also be reflected
on the Site Configuration window described on page 2-16.

To

open the Site Configuration window, select the Site item from the

Configuration menu, or press the keys CTRLA+I.

Site Name — The site identification string (up to 20 alphanumeric
characters).

Antenna Status — This control allows the user to define whether the receiver
antenna is in motion or is motionless.

Antenna Height — The height of antenna, measured from the survey marker
to the measuring mark of antenna. The measuring mark is the antenna
reference point (ARP) if you use the vertical height or a known measuring
mark (usually antenna edge) on the antenna if you use the slant height.

Slant — Enable this checkbox if you measure the slant height. Otherwise,
leave it blank.

Antenna Type — Select the type of antenna you use.

Send parameters automatically — Select this checkbox if you want PCView
to automatically send the above site and antenna parameters to the receiver
on every log file creation event.

OK - Applies the changes and closes this window.
Send to receiver — Applies the changes when the log file is being recorded.

Cancel — Closes the window without applying the changes.
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Target position Window

This window allows the user to enter the target coordinates (Figure 2-41).

“ Target position

Lat[55 | “[4z |'[5128230 '[N =]
Lonf37 | *[35 |'[3456335 '[E =]
0K I Get from recerver I Cancel |

Figure 2-41. Target position Window
To go to the Target position window, either select the Target Position from the
Configuration menu, or press the keys CTRL+T.

* OK - Associates the entered coordinates with the target position and closes
the window.

* Get from receiver — Sets the target position to the most recent position
produced by the receiver.

* Cancel — Closes the window without applying the coordinates.
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RFM96 Configuration Window

If your receiver is equipped with the RFM96 radio modem, use the following
windows to adjust its settings.

To open the RFM96 Configuration window, select the Radio item from the
Configuration menu, then click RFM96, as shown in Figure 2-42.

I?onfiguran’on
Receivar Chrl+f

Site Crrl+l
Target cosition Chl+T

Fi adia s m : !I

Figure 2-42. Select Radio->RFM96

After you click the RFM96 item, the following window displays (Figure 2-43).
I

Connect I

Modem connected to port: | C it
Eormnect to modern st bitrated| Auto b
~Connection type
= Search for modem 1 Power cycle
Turn the madem power off [or slide the modem fram the
receiver). Then tun the modem power on [or slide the
modem into the receiver).
Cannect step | g |
|Logking for modem... [ TT]

Figure 2-43. RFM96 Configuration - Connect
This tab allows the user to establish a connection with the radio modem.

Use the Modem connected to port list box to select the receiver port that the
radio modem is connected to.

To set the baud rate with which the modem and receiver will communicate, use
the Connect to modem at bitrate list box (typically 38400 bps). If you want
the receiver automatically detects the baud rate, select Auto.

Select the method of modem connection and click Connect. For most RFM96
models, you can use Search for modem.

If the radio is not found, change Connection type to Power cycle and click
Connect. The program will prompt you to turn the modem off and then back on
(Figure 2-44 on page 2-71). The program will poll the radio during its power
cycle and establish a connection.
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Modem connected to port: |C 'i
Zantiest to modern at bitrate |.~5.utc- et I

Connection type:
’7(" Search for modem % Power cycle

Turn the modern power off [or zlide the modem from the
receiver]. Then tumn the modem power on [or slide the
madem into the receiver).

Conrect I Stop I Exit

|Locking Far madsrn.... (1]

Figure 2-44. RFM96 Configuration - Power Cycle

Once a connection has been established, you will see a window showing the

radio link settings and protocol details (Figure 2-45).

@ RFM3I6 Configuration
Configuration |
Serial No: 38437777

RF Chawnel———— Radio Link Settings——
2 [469.5500.453.5600) || Link rate: 600 7
0 (4645500 464 5500] = |Retries: 3 =
1 (464.50004645000) : =
2 (459 5500 459 5500) FEC: ot
3 (469.5000.469.5000) _| |Sciambling: [0 =
: I
5 Digisquelch Low =
W | | C5MA monitar: | On =

DTE-DCE protocol mode
’7Fast asyhc ~| [T BREAK to Cammand ‘

~Addresse:
| Al Iﬂ - Nestinatinn | 7FR ¥ ‘
Disconaect I Refresh I Apply I Set defauls I

Figure 2-45. RFM96 Configuration - Settings

 In the RF Channel list box, the user selects the desired channel.
* In the DTE-DCE Serial Interface area, the user specifies the following

settings:

Baud rate — Select the baud rate used for communication with the local

DTE device.
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Parity — Select the parity used for communication with the local DTE
device.

EOT - This field is set to the end-of-transmission character or timeout
value used to determine when a message that is to be transmitted is
complete and ready to transmit. This applies only when the DTE-DCE
protocol of the radio-modem is configured for Transparent, Fast
Asynch, or TrimTalk modes.

* In the DTE-DCE protocol mode, select the desired operation protocol
among the following available:

Transp. w/EOT time out
Transp. w/EOT character
Packet

Auto-repeater

Fast async

Enable/disable the BREAK to Command checkbox. If enabled, a BREAK
condition on the RS-232 interface will cause the radio-modem to switch
into command mode.

* In the Addresses area, specify the Local and Destination addresses. The
Local field is set for the local radio modem identifier. In packet switched
and addressed transparent operation each modem should be assigned a
unique address. Packets may be sent to a specific address, or broadcast to a
group of modems. Acceptable values are 0 to 254. Do not use address 255
as it is reserved as the broadcast address. Destination is used only in
transparent mode for addressed transparent operation. When in transparent
mode, all data is transmitted to the address specified in this field.

* In the Radio Link Settings area, specify the following settings:

Link rate — This list box field allows you to select the rate at which data
is transmitted over the RF link. Pacific Crest recommend the use of
9600 bps to minimize the power consumption and to maintain the radio
transmitter at a low TX duty cycle. You may need to use 4800 bps in
order to maintain reliability in difficult transmission circumstances
(long range or heavy fade conditions).

Retries — Enter in this field the number of retries the modem should
attempt in the case where the remote modem does not respond or a
corrupted data packet causes a negative acknowledgment from the
receiving modem. This field is only used when the modems are in
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packet mode or operation or when the modems are in transparent mode
with a designated destination address other than 255.

FEC - Enable or disable Forward Error Correction (FEC). FEC allows
the receiving modem to correct burst and single bit errors in the
incoming data stream. When enabled, an additional 4 bits per byte of
data is transferred over the RF link. This effectively reduces the data
throughput in proportion to the overhead bytes. Leave FEC enabled
unless the data throughput requirements make the overhead
unacceptable.

Scrambling — This list box is used to enable or disable data scrambling.
For optimal operation of the GMSK modulation, data should be
scrambled. When enabled, the radio modem scrambles and unscrambles
the data on transmission or reception via an exclusive-OR operation
with a pseudo-random bit stream. Do not disable scrambling unless the
DTE performs data scrambling and produces a data stream with
approximately the same number of 1's and 0's.

Digisquelch — The receiving modem attempts to decode the radio
information only in conditions where the radio signal is of a certain
power level. The radio modem allows the user to select the level at
which the radio begins to decode the signal. By adjusting the sensitivity
to an RF carrier, the radio modem can be configured to ignore weak
signals, or signals from unintentional radiators (computer CRT's, etc.)
which would otherwise interfere with reception. Four settings are
provided: High, Moderate, Low and Off. Select High for greatest
sensitivity. A selection of High will result in the best range of reception.
Select Moderate or Low to minimize interference from other
transmissions. Note that selecting Moderate or Low will result in poorer
reception of weak signals, and lower range. By selecting Off, the radio
modem loses its ability to receive signals, and thereby becomes a
transmit only unit. Note that selecting Off will allow the radio modem
to transmit over other broadcasts, and is generally not recommended,
especially at higher power levels where your broadcast will interfere
with co-channel users.

CSMA monitor — This field instructs the modem to wait, or not, for the
transmit frequency to clear before attempting transmission. This is most
useful when the RX and TX frequencies are different. When set to On,
the modem will check for clear TX frequency. If the TX frequency is
busy, the modem waits a random time period and repeats the check.
When the TX frequency is clear, transmission will commence. When set
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to Off, transmission will commence without first checking for clear TX
frequency.

Once the change has been made, press the Apply button to program the radio.

Pressing the Set defaults button returns all radio link and serial interface
settings back to their factory default values.

Digisquelch should be set to Low on the base and High on the rover. If the radio
at the rover is suffering from an external interference, then you can set it to
Medium or Low.

Notice: For more information on the settings used in this window, refer to
the RFM96 Modem Configuration Software help.
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Initialize file system

This procedure is to some extent similar to disk formatting. It results in erasing
all of the files inside the receiver. In practice, you do not execute this procedure
very often.

To initialize the file system in the connected receiver, select the Initialize file
system item from the Tools menu.

After pressing Initialize file system, you will be prompted to confirm the
command (Figure 2-46).
Initialize Fie Spstem

Thiz operation will erase all the files inside the receiver.
trnay bake up o 10 minutes, depanding on the recaiver mermaony size.
Jo you really wizh to continue?

1 me |

Figure 2-46. Confirm Initialization - 1

On the next window, confirm the initialization by clicking the Start button
(Figure 2-47).

&7 Initializing Receiver File System

This is wour last chance to cancel
initializing the receiver's file system
Press Start to continue with
initializing.

Cancel |

Figure 2-47. Confirm Initialization - 2

Wait until the initialization process completes (Figure 2-48).

& Initializing Receiver File System ' X|

Pleaze, wait!

AENRNNENANNNNENNREEREN
1533 of 1960

|

Figure 2-48. File System Initializing

Notice: The command'’s execution time may be up to several minutes
depending on the receiver's memory size.
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Once completed, the window showing the receiver’s file system and physical
memory information appears. If you want to save this information to a text file,
click Save to file. To close the window, click OK (Figure 2-49).

S Initializing Beceiver File System

Ready!
NENENENEEENNEENNEENEENEEEED
1960 of 1960

File System Information _‘J
“ersion: 3000103
Block size: 16376 bytes
Blocks: 1959
Total mermon: 32080584 bytes
Free memorns 32080584 bvtes
Bad hblocks: o
Mrite werifys fast

FPhysical Memory Information
Block size: 512 bytes
Blocks far files: 2720
Physical memony: 32112640 bytes
|

Refresh I Save tao file | 0K I

Figure 2-49. File System Has Completely Initialized
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Clear NVRAM

www.javad.com

The receiver’s Non-Volatile Random Access Memory (NVRAM) holds data
required for satellite tracking, such as ephemeris data, almanac data, and
receiver position. The NVRAM also keeps the current receiver’s settings, such
as active antenna input, elevation masks and recording interval, and information
about the receiver’s internal file system.

Even though clearing the NVRAM is not a common (nor normally a
recommended) operation, there are times when clearing the NVRAM can
eliminate communication or tracking problems. Clearing the NVRAM in your
receiver can be interpreted as a soft boot in your computer.

After clearing the NVRAM, your receiver will require some time to collect new
ephemerides and almanacs (around 15 minutes).

Clearing the NVRAM of your receiver will not delete any files already recorded
in your receiver’s memory. However, it will reset your receiver parameters to
factory default values.

In addition, the NVRAM keeps information about the receiver file system. Note
that after clearing the NVRAM, the receiver's STAT LED will flash orange for
a few seconds indicating that the receiver is scanning and checking the file
system.

To clear the NVRAM, select the Clear NVRAM item from the Tools menu.
PCView then prompts you with a message asking to confirm clearing the
NVRAM. Click OK to execute this procedure or Cancel to return to the main
window (Figure 2-50).

Clear HVYRAM

zome time to re-collect data needed to track satelites.

,@ After clearing MYRAM the receiver will require
Push OF. to proceed, Cancel to abort.

Ok I Cancel |

Figure 2-50. Confirm Clear NVRAM
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Reset receiver

This operation is similar to computer resetting. It will not clear the receiver's
NVRAM.

To reset the receiver, select the Reset receiver item from the Tools menu.
When clicking the Reset receiver option, you will be prompted to confirm your
command (Figure 2-51).

Reset Receiver

|/$' After resetting the receiver will require
\.E) zome time to re-collect data needed to track satelites.

Push OF. to proceed, Cancel to abart.

Cancel

Figure 2-51. Confirm Receiver Reset

After the command is executed, PCView disconnects itself from the receiver
and then opens the Connection Parameters window prompting you to set
necessary parameters to connect to the receiver again.
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By clicking the Receiver options item, the Option Manager window displays.
With this window you can check the status of your receiver’s options and load
new Option Authorization Files (OAFs) to the receiver (Figure 2-52).

X

Option name | Current | Purchaged | Leased | Exp. date | o
GPS yes no Ve 30.09.2005
GLOMNASS yes ho = 30.09.2005
L1 yes no YEs 30.09.2005
L2 yes no e 30.05.2005
Cinderella yes hio [ 30.09.2005
Pozition update rate [Hz) 20 i] 20 30.09.2005
Raw data update rate Hz) 20 1] 20 30.09.2005
Code differential Base yes no VEs 30.09.2005
Code differential Rover yes no ey 30.05.2005
RTK Base yes 3] [ 30.09.2005
RTK. Rover [Hz) 20 1] 20
Memary [ME] 0 O S
Common Tracking yes no ves 30.09.200
1-FP5 Timing Signal 2 0 2 30.09.2005
Event Markers 2 1] 2 30.09.2005
In-Band Int. Rejection | e i] 1 30.05.2005
Multipath R eduction yes hio Yes 30.09.2005
Frequency Input yes no e 30.09.2005
Freq. Lock and Output yes ho ey 30.09.2005
Serial Port & [Kbps) 450 0 460 30.09.2005
Serial Port B [Kbps) 460 0 460 30.09.2005
Serial Port C [Kbps) 460 0 460 30.09.2005
Serial Port D [Kbps] 480 i 460 30.09.2005
Infrared Part | e ho = 30.09.2005
Parallel Fort no ves 3009.200 T
Sp.5p. Freq Hop. no e 30.05.2005
SpSp Diect | e hi Yes 30.09.2005
Rl yes no Ve 30.09.2005
Datumsz suppart yes hio YEs 30.09.2005
Magnetic azimuth ves no ves 30.09.2005
Geaid height yves ho e 30.09.2005
“wiay Point Mavigation | s hia no
WAAS yes no e 30.05.2005
OMMISTAR e na yes 30.09.2005
RTCH Dutput 3 0 3 30.09.2005
RTCH Input 5 0 5 30.09.2005
RTCh 3 Output 3 0 3 30.09.2005
RTCH3 Input 1 0 1 30.09.2005
CMR Dutput 1 0 1 30.09.2005
CHR Input 1 0 1 30.05.2005 LI
1DC Mk b 1 n n

Refresh Load Stop E it I

Figure 2-52. Option Manager
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Option Manager Window

This window contains the following information (Figure 2-52 on page 2-

79):

* Option name — a name/description of the option

* Current — shows if the option is in force at the present or not

* Purchased — if the option is purchased or not

* Leased — if the option is leased or not

» Expiration date — the date the leased option will be disabled, if

applicable

Since Options can be both purchased and leased, the «Current» status of the
option displays the currently effective value.

Option values can be:

* -1 or «----» — the firmware version does not support this option.

* 0 — the receiver option is disabled.

* positive integer — the option is enabled with a specified value.

* yes or no — the option is either enabled or disabled.

Table 2-7 lists all options available for a JNS receiver.

Table 2-7. Receiver Options

Option Name

Description

Values

GPS

Enables/disables the use of GPS
satellites.

yes — enabled
no — disabled

GLONASS

Enables/disables the use of GLO-
NASS satellites.

yes — enabled
no — disabled

L1

Enables/disables the receiver to
track the L1 carrier frequency and
use the C/A-code measurements
for position computation.

yes — enabled
no — disabled

L2

Enables/disables the receiver to
track the L2 carrier frequency and
use the P-code measurements on
L1 and L2 for position computa-
tion.

yes — enabled
no — disabled
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Table 2-7. Receiver Options (Continued)

Option Name

Description

Values

Cinderella

Enables/disables the Cinderella
option. It turns a single frequency,
GPS receiver into a dual-fre-
quency, GPS+GLONASS
receiver for 24 hours every other

Tuesday at GPS midnightl.

yes — enabled
no — disabled

Position update rate
(Hz)

Displays the maximum allowable
position update rate for autono-
mous and code differential posi-
tioning. Measured in Hertz.

0,1,2,5, 10, 20.
Zero means that the
option is disabled.

Raw data update rate
(Hz)

Displays the maximum allowable
raw measurement update rate.
Measured in Hertz.

0,1,2,5, 10, 20.
Zero means that the
option is disabled.

Code differential Base

Enables/disables the receiver to
be configured as a DGPS Base.
This option is obsolete and retains
in the program for back-compati-
bility.

yes — enabled
no — disabled

Code differential Rover

Enables/disables the receiver to
be configured as a DGPS Rover.
This option is obsolete and retains
in the program for back-compati-
bility.

yes — enabled
no — disabled

RTK Base Enables/disables the receiver to yes — enabled
be configured as an RTK Base. no — disabled
This option is obsolete and retains
in the program for back-compati-
bility.

RTK Rover (Hz) Enables/disables the receiver to 0,1,2,5,10,20.
be configured as an RTK Rover Zero means that the
with the desired RTK position option is disabled.
update rate. Measured in Hertz.

This option is obsolete and retains
in the program for back-compati-
bility.
Memory (Mb) Displays the maximum amount of | 0 — disabled

storage space for raw data files.
Measured in Mbytes.

1...6256 — enabled for
specified memory
space

Common Tracking

Enables/disables the use of the
Common tracking feature.

yes — enabled
no — disabled
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Table 2-7. Receiver Options (Continued)

Option Name

Description

Values

1-PPS Timing Signal

Enables/disables the receiver to
output 1 PPS signal.

0—no 1 PPS output
1 —single 1 PPS output
2 —dual 1 PPS output

Event Markers

Enables/disables the receiver to
accept event marker inputs.

0 — no event marker
input

1 —single event marker
input

2 — dual event marker
input

In-Band Int. Rejection

Enables/disables the receiver to
use Jamming Suppressor.

0 — disabled

1 — enabled outside
USA

2 —enabled for USA
only

Multipath Reduction

Enables/disables the use of a spe-
cial signal processing technique
that significantly reduces the
effects of multipath.

yes — enabled
no — disabled

Frequency Input

If enabled, allows the receiver to
operate with an external high-sta-
bility frequency source.

yes — enabled
no — disabled

Freq. Lock and Output

Enable the receiver to generate a
very stable 20 MHz frequency.

yes — enabled
no — disabled

Serial Port A (Kbps)

Enables/disables communica-
tions through port A and displays
a maximum available baud rate at
which the receiver communicates
with an external device. Mea-
sured in Kbits per second.

0 — port disabled

Serial Port B (Kbps)

Enables/disables communica-
tions through port B and displays
a maximum available baud rate at
which the receiver communicates
with an external device. Mea-
sured in Kbits per second.

9 -9600

19 — 19200
38 — 38400
56 — 56700
115 - 115200
230 - 230400
460 — 460800
0 — port disabled
9 -9600

19 - 19200
38 — 38400
56 — 56700
115 - 115200
230 — 230400
460 — 460800
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Table 2-7. Receiver Options (Continued)

Option Name

Description

Values

Serial Port C (Kbps)

Enables/disables communica-
tions through port C and displays
a maximum available baud rate at
which the receiver communicates
with an external device. Mea-
sured in Kbits per second.

0 — port disabled

Serial Port D (Kbps)

Enables/disables communica-
tions through port D and displays
a maximum available baud rate at
which the receiver communicates
with an external device. Mea-
sured in Kbits per second.

9 -9600

19 — 19200
38 — 38400
56 — 56700
115 - 115200
230 - 230400
460 — 460800
0 — port disabled
9 -9600

19 — 19200
38 — 38400
56 — 56700
115 - 115200
230 - 230400
460 — 460800

Infrared Port

Enables/disables communica-
tions through infrared port.

yes — enabled
no — disabled

Parallel Port

Enables/disables communica-
tions through parallel port.

yes — enabled
no — disabled

Sp.Sp. Freq. Hop.

Allows use of the internal Spread
Spectrum modem in the fre-
quency hopping mode. For the
Legacy and Odyssey only.

yes — enabled
no — disabled

Sp.Sp. Direct

Allow use of the internal Spread
Spectrum modem in the spread
spectrum mode. For the Legacy
and Odyssey only.

yes — enabled
no — disabled

RAIM

Enables/disables Receiver Auton-
omous Integrity Monitoring.

yes — enabled
no — disabled

Datums support

Enables/disables the receiver to
output position information in a
datum other than WGS 84 or PE-
90.

yes — enabled
no — disabled

Magnetic azimuth

Enables/disables the receiver to
output the magnetic course.

yes — enabled
no — disabled

Geoid height

Enables/disables the receiver to
use embedded low-accuracy
geoid model with RMS of about 3
m.

yes — enabled
no — disabled
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Table 2-7. Receiver Options (Continued)

Option Name Description Values
Way Point Navigation N/A always disabled
WAAS Enables/disables the receiver to yes — enabled
use the WAAS service. no — disabled
OMNISTAR Enables/disables the receiver to yes — enabled
use the OmniSTAR satellite dif- no — disabled
ferential service.
RTCM Output Allows the receiver to output 0 — RTCM output dis-
RTCM messages. abled
1 — DGPS RTCM out-
put enabled
2 — RTK RTCM output
enabled
3 - DGPS&RTK
RTCM output enabled
RTCM Input Allows the receiver to accept 0 — RTCM input dis-
RTCM messages via a certain abled
number of ports. The option value 1,2,3,4,5-RTCM
represents the number of ports input enabled on a
from which the receiver is able to specified number of
simultaneously accept RTCM ports.
messages.
RTCM3 Output Allows the receiver to output 0 —RTCM 3.0 output
RTCM 3.0 messages. disabled
1 - DGPS RTCM 3.0
output enabled
2 -RTK RTCM 3.0
output enabled
3 - DGPS&RTK
RTCM 3.0 output
enabled
RTCM3 Input Allows the receiver to accept 0 — RTCM 3.0 input
RTCM 3.0 messages via a certain | disabled
number of ports. Currently can be 1 — RTCM 3.0 input
setto 0 and 1. enabled on a port.
CMR Output Allows the receiver to output 0 — CMR output dis-
CMR messages. abled
1 — CMR output
enabled
CMR Input Allows the receiver to accept 0 — CMR input dis-
CMR messages abled
1 — CMR input enabled
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Table 2-7. Receiver Options (Continued)

Option Name

Description

Values

JPS Output Allows the receiver to output NS | 0 —JNS output dis-
messages. abled
1 — JNS output enabled
JPS Input Allows the receiver to accept INS | 0 —JNS input disabled
messages via a certain number of 1,2,3,4,5-JNS input
ports. The option value represents | enabled on a specified
the number of ports from which number of ports.
the receiver is able to simulta-
neously accept JNS messages.
DGPS mode Enables/disables the receiver to yes — enabled

run in DGPS (Code Differential)
mode.

no — disabled

RTK mode (Hz)

Enables/disables the receiver to
run in RTK mode at a specified
rate. Values are given in Hertz.

0 — disabled

1 —enabled @ 1 Hz

2 —enabled @ 2 Hz

5 —enabled @ 5 Hz
10 — enabled @ 10 Hz
20 — enabled @ 20 Hz

Carrier Phase

Enables/disables true carrier
phase output. If the option is
enabled, true carrier phase is out-
put. If the option is disabled, inte-
gral Doppler is output for true
carrier phase. In this case the
option RTK mode will not be
fully available because only float
solutions can be obtained when
RTK using integral Doppler for
true carrier phase. In JNS receiv-
ers other than JGG20 and HEGG,
this option is always enabled.

yes — enabled
no — disabled

Ethernet Port

Enables/disables the receiver to
communicate over Ethernet.

yes — enabled
no — disabled

TCP Connections

Enables/disables the receiver to
establish a certain number (5
max.) of simultaneous Telnet-like

0 — disabled
1,2,3,4,5 - number
of enabled Telnet con-

connections. nections.
FTP Connections Enables/disables the receiver to 0 — disabled
establish an FTP connection (1 1 — enabled

max.).
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Table 2-7. Receiver Options (Continued)

Option Name

Description

Values

USB Port Enables/disables communica- no — disabled
tions through USB port. yes — enabled
ADU Enables/disables the receiver to 0 — disabled
act as an attitude determination 1 —enabled for heading
unit. and pitch computation
2 — enabled for head-
ing, pitch, and roll
computation
CDU Support Enables/disables the receiver to no — disabled
be connected to the CDU-1 yes — enabled
device.
Reserved For internal purposes only. no — disabled
Authorization Enable/disables the receiver to be 0 — not authorized

authorized to work with a number
of programs. This is a bit-field
option, where each bit corre-
sponds to a specified software.

Ensemblelst bit (deci-
mal 1) — authorized for
Ensemble

2nd bit (decimal 2) —
authorized for
PCView MS

3rd bit (decimal 4) —
authorized for Top-
Net+

Combinations of these
values are also avail-

able.
RTK distance [x100m] This option determines the maxi- 0 — disabled
mum allowed distance in hun- 511 — enabled without
dreds of meters between the restriction

reference and rover stations. If the
distance between the reference
and rover stations exceeds the
specified limit, the receiver will
not provide the RTK position.

1...510 — enabled for
specified distance
For example, 120
means 12 km.
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Table 2-7. Receiver Options (Continued)

Option Name

Description

Values

Corrections inputs

Enables/disables the correspond-
ing port to be

set to any differential data input
mode.

This is a bit-field option, where
each bit corresponds to a speci-
fied port.

0 — differential data
inputs are disabled on
all ports

1st bit (decimal 1) —
serial port A is enabled
for differential data
input

2nd bit (decimal 2) —
serial port B is enabled
for differential data
input

3rd bit (decimal 4) —
serial port C is enabled
for differential data
input

4th bit (decimal 8) —
serial port D is enabled
for differential data
input

Combinations of these
values are also avail-
able.

Latitude 1

Specifies the latitude of the upper
left corner of the rectangle area
within which the receiver can pro-
duce the position information and
output measurement data.
Measured in degrees.

from -90 to 90

Longitude 1

Specifies the longitude of the
upper left corner of the rectangle
area within which the receiver can
produce the position information
and output measurement data.
Measured in degrees.

from 0 to 360

Latitude 2

Specifies the latitude of the lower
right corner of the rectangle area
within which the receiver can pro-
duce the position information and
output measurement data. Mea-
sured in degrees.

from -90 to 90
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Table 2-7. Receiver Options (Continued)

Option Name Description Values

Longitude 2 Specifies the longitude of the from 0 to 360
upper left corner of the rectangle
area within which the receiver can
produce the position information
and output measurement data.
Measured in degrees.

Lat_Lon checksum 1 Checksum of the Latitudel, from 0 to 511
Longitudel, Latitude?2, 0 — indicates that the
Longitude2 options. See the receiver is disabled to
GRIL Reference Manual for compute its position
details on how the checksum is and output raw data
calculated. measurements

Latitude 3 Specifies the latitude of the upper from -90 to 90

left corner of the second rectangle
area within which the receiver can
produce the position information
and output measurement data.
Measured in degrees.

Longitude 3 Specifies the longitude of the from 0 to 360
upper left corner of the second
rectangle area within which the
receiver can produce the position
information and output measure-
ment data.

Measured in degrees.

Latitude 4 Specifies the latitude of the lower | from -90 to 90
right corner of the second rectan-
gle area within which the receiver
can produce the position informa-
tion and output measurement
data. Measured in degrees.

Longitude 4 Specities the longitude of the from O to 360
upper left corner of the rectangle
area within which the receiver can
produce the position information
and output measurement data.
Measured in degrees.

Lat_Lon checksum 2 Checksum of the Latitude3, from O to 511
Longitude3, Latitude4, 0 — indicates that the
Longitude4 options. See the receiver is disabled to
GRIL Reference Manual for compute its position
details on how the checksum is and output raw data
calculated. measurements
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1. Cinderella activates only if the receiver hardware supports GLONASS and
the L2 frequency.

Also this window contains four buttons. Their functions are:
» Refresh — Updates the window.

¢ LLoad — Loads a new OAF. For details, see “How to Load New OAF to
Receiver” .

* Stop — Terminates loading an OAF.
* Exit — Closes the window.

How to Load New OAF to Receiver

1. In the Tools menu, select the Receiver options item.
2. Click Load at the bottom of the Option Manager window.

3. Navigate to the location of the new Option Authorization File. OAFs have
.jpo extensions and are unique to each receiver.

4. Select the appropriate file and click Open. The new receiver options will
load onto the receiver and the Option Manager table will update.

5. When finished, PCView will restart the receiver to activate new values of
the options.
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Scatter Plot Window

This is a useful graphic feature allowing you to monitor the behavior/quality of
the receiver trajectory/position in real time.

To go to the Scatter Plot window, select the Scatter item from the Plots menu.

The window is divided into the scatter plot and an augmented status bar
(Figure 2-53).

@ §catter _[O]
40

30

Awg, Lat 55° 42'51,3650" N [RMS Pos ho: 2,1872 m ‘F\MS Yelhar 00213 m
Awg Lom 37° 35' 34 4665"E  |[RMS Posver: 31124 m  AMS Welwer 00311 m
Awg Al 1977050 m |RMS Pos: 38041 m ‘F\MS Wel 0,030 m

Total: 3021 Standalone: 100% Code dift: 0%  RTK float 0% RTK fized 0%

taw ETT: -4.318m  Maxw NTT: 5332m Avg ETT: 0009 m  Awg NTT: -0.070m

Clear all pints | Fit all paints
Figure 2-53. Scatter Plot Window

The plot displays the current receiver position relative to the position specified
in the Target position window. The most current receiver position is showed by
a red point.

Status bar contains the following information:

* Average latitude, longitude and ellipsoidal height of the receiver’s position
over the entire set of obtained position estimates

* Horizontal position RMS error
* Vertical position RMS error

* Total position RMS error, i.e. the square root of the trace of the position
error variance-covariance matrix

* Horizontal velocity RMS error
* Vertical velocity RMS error
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* Total velocity RMS error, the square root of the trace of the velocity error
variance-covariance matrix

* The number of the position estimates for each of the four solution types (in
%) and their total as well

* The maximum and average Easting to Target and Northing to Target in the
local system with the origin at the receiver.

Use the Clear all points button to erase all plotted points in the window.

When you click the Fit all points button, PCView will automatically change the
scale of scatter plot allowing you to view all plotted positions currently gathered
by the software.

After you click Target to average, PCView sets the target position equal to the
average receiver’s position.

The scatter plot and information in the status bar are updated
once a second, unless you specified a lower position or raw
data update rate at your receiver.

If you close this window, the positions displayed in the scatter
plot and information in the status bar will not be discarded
(unless you disconnect the receiver), thus when you reopen the
window later, it will include both the current position information
and data.
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Satellites Plot Window

The Satellites Plot

window shows graphic representation of the satellite

positions in the sky (Figure 2-54).
To go to the Satellites Plot window, select the Satellites item from the Plots

menu.

@ Satelliles =

GDOP: 1,893

PDOF: 1,565
HDOP: 0,798
VDOF: 1,318

13=10+3

Elgvation nask
Clear data

G2 G3 GI 511 514515518521 528531 R? Rﬂ H24
LI T T

Figure 2-54. Satellites Window

Each concentric circle represents the elevation angle above the horizon.

The outermost circle corresponds to 0 degrees above the horizon.

The center of the sky plot represents 90 degrees above the horizon.

The dotted circle shows the position computation elevation mask angle. In
Figure 2-54, the mask angle equals 5 degrees. The user can adjust the mask
angle through the Elevation MaskForm window which appears immediately
after clicking the Elevation mask button (Figure 2-55).
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Also, the user can see four DOP characteristics, specifically:

* GDOP - Geometrical Dilution of Precision (3 position coordinates plus
clock offset in the solution)

e PDOP - Position Dilution of Precision (3 coordinates)
¢ HDOP - Horizontal Dilution of Precision (2 horizontal coordinates)
* VDOP - Vertical Dilution of Precision (height only)

A dynamically changing histogram shows the signal-to-noise ratio (C/N) in the
C/A channel. Each vertical bar has a unique color and designates a satellite’s
PRN (GPS and WAAS) or slot number (GLONASS). Note that GPS/WAAS
and GLONASS satellites are marked with G# and R#, respectively. By selecting
or clearing the checkbox for each SV, the user can specify which of the GPS,
GLONASS and WAAS satellites are enabled/disabled for position computation.

To view the basic tracking information about a
satellite, move the cursor onto the desired satellite’s
icon and right-click on it. Holding down the right
button, you will see a pop-up window, as shown in
Figure 2-56. The values in the window are similar to
the values in Main window.

EL AZ CA P1 P2 55
B3 229 52 17 17 O

4 data uzed for position
computation

Figure 2-56. Satellites Plot Window - Basic Tracking Information

To clear the Satellites Plot window, click the Clear data button.
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Position Plot Window

The Position Plot window represents continuously updated graphs that show
the difference between latitude/longitude of the receiver position and latitude/
longitude specified in the Target position window over a user-defined time
interval (Figure 2-57).

To go to the Position Plot window, select the Position item from the Plots
menu.

2 Position

TEEm Latitude

Figure 2-57. Position Plot Window

The Latitude and Longitude graphs are constructed as follows:
* Horizontal axes

Display the time interval (in seconds) over which PCView computes the
differences.

—The range of a time interval, over which the differences are displayed,
varies between 0 seconds (which corresponds to the current moment in
time) and a value entered in the Time interval parameter from the Plots
Configuration window.

—The interval between values along the axes corresponds to a value of the
Time step parameter specified in the Plots Configuration window.

For example, the graphs in Figure 2-57 on page 2-94 show the range of
values O s to 360 s with the interval of 20 s.

¢ Vertical axes

Display the difference (in meters) between a particular position of your
receiver and a fixed position of a target.

—The range of deviations that can be viewed, sets in the Max. deviation
parameter of the Plots Configuration window.
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—The interval between values along the axes corresponds to a value of the
Deviation step parameter in the Plots Configuration window.

For example, the graphs in Figure 2-57 on page 2-94 show the range of
deviations 0 m to 30 m with an interval of 10 m.
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Plots Configuration

With the controls in this window, the user configures the settings in the Scatter,
Satellites and Position windows (Figure 2-58 on page 2-96).

To go to the Plots Configuration window, select the Configuration item from
the Plots menu.

“ Plots Configuration

~Points colors——— | Scatter
Standalone Plot width:  [100.0000 | ] I Standalone
Code differential Iv Code differential

] e
BTK flaat . Tick interval: |1 0.0000 [rin) I BTK float
]

RITK fixed ¥ Showgid [ Connectpoints [ RTK fived
—Pozition General

Time interval:  |360 () P e ey [EEED__

M ax. dewviation: IW {m, 0 for auta)

M Show grid

Time step: I'|5_ (5]

Drerviation step: IEEE-D_ [m] e T

Figure 2-58. Plots Configuration Window

In the Points colors area, the user can change the color for the points of the
Scatter window.

For example, if it is desired that the points corresponding to the absolute

position estimates, be displayed in red, take the following steps:

1. Move the cursor onto the colored box, which is on the right side of

Standalone.
2. Click either mouse button in a fill area of the box.

3. Click the color wanted. If the color desired is not seen, click Define
Custom Colors>>. To the right of Basic colors you will see a custom
palette where you can mix your own color. After selecting the color you
want, click Add to Custom Colors, and then click OK.

In the Scatter group box, the user can change the settings related to the Scatter
window.

* With the Plot Width edit box, the user specifies the length of the axes on
the plot.
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The Tick Interval edit box specifies the tick size (in meters) between the
adjacent concentric circles (i.e., interval between adjacent values on the
axis).

To remove the circle grid from the plot, clear the Show grid checkbox.

With the Connect points checkbox, the user can select whether to plot the
positions as discrete points (checkbox disabled) or as a trajectory (checkbox
enabled).

With the Standalone, Code Differential, RTK float and RTK fixed
checkboxes, the user specifies what kinds of solutions will be shown on the
plot. It is recommended that you use a unique color for each solution type.

The Position group box contains the settings that govern the graphs in the
Position Plot window.

The Time interval edit box specifies the length of the x axis (in seconds).

The Max. deviation edit box specifies the length of the y axis (in meters).
Zero means that the vertical axes will always be scaled automatically
according to the maximum deviation value within the currently displayed
time interval.

To turn off the grid, clear the Show grid checkbox.

The Time step edit box specifies the time (in seconds) between adjacent
vertical gridlines.

The Deviation step edit box sets the distance (in meters) between adjacent
horizontal gridlines.

The Values to keep edit box determines the size of a circular buffer used to
store the positions of the receiver’s antenna. The default value is 3600. When
the buffer is full, the new values overwrite the oldest. This circular buffer is
used with the aim of saving the computer memory consumption when the
graphs have been being monitored for a long time (continuously during several
hours, days, etc.).

To commit any changes that you have made, click Apply.
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About PCView Window

The About PCView window shows software version information and, after
establishing connection, information about the receiver (Figure 2-59).

. About PCView

Yersion 2.1.74 Lite (Build: October 14, 2004)
Status : Never expired
Copyright ® Javad Mavigation Systems . 2000 - 2004 Eedeaated
hittp: /v javad. com

PCiew for “Windows 95/98/ME/MT 2000/ 7
155
(22,

Receiver modsl: MAXOR »
Receiver D: REMYEYZF W0

Firmware version: 2.5 Feb.18,2005 b4

RTK support yes

Mainboard version: MGGDT_S

FAM size: 4096KB

Fower supply (v): 0.0

Antenna input int

Ext. Ant. DC status:  off

Digital part 33V (v): 3.3
Analog part 3.3V (v 3.3
Digital part 5% (v): 5.1
Analog partBY (V) 45
Temperature ("Cl: 379

Flash memony size: 134078472 bytes
Flash memonyfree: 133947408 bytes

Mumber of files: 0

Bad blocks 1

W'rite verify: fast

Block size: 131072 bytes

Blocks for files: 1024

Fhysical memary: 134217728 bytes

Current port Jdeviserb

Speed: 115200 v
Save to file | Report | Refresh | oK |

Figure 2-59. About PCView Window

To access the About PCView window, either select the About item from the
Help menu, or press the keys CTRL+U.

Table 2-8 gives a description of each of the fields in this window.

Table 2-8. Connected Receiver Details

Field Description
Receiver model The model of the connected receiver.
Receiver ID The electronic identifier of the connected receiver.
Firmware version The firmware version installed on the receiver.
RTK support Shows whether the receiver can work in RTK mode.
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Table 2-8. Connected Receiver Details (Continued)

Field

Description

Mainboard version

The version of the GPS board.

RAM size

The size of the receiver RAM in kilobytes.

Power Board

The hardware and firmware version of the power board
installed on the receiver.

Power supply (V)

The voltage of the external power supply.

Antenna input

Shows whether the receiver uses internal or external
antenna to acquire the GPS/GLONASS signals.

Ext. Ant. DC status

Indicates if an external antenna draws acceptable DC
current.

Power source

Shows the power source used by the receiver.

Power cur.source

Displays the power source that is currently being used
by the receiver.

Charger status

Displays the mode of a charger used to restore power to
internal batteries.

Charger cur.status

Displays the current mode of a charger.

Battery A(V) Shows the voltage of the battery A.

Battery B(V) Shows the voltage of the battery B.

On board (V) Displays the voltage the receiver board draws.

Charger (V) Displays the output voltage of the internal charger dur-
ing battery charging.

On ports (V) Displays the output voltage on the first pin of each of the

receiver’s serial port.

Digital part 3.3V (V)

Displays the voltage across the digital part of the
receiver board.

Analog part 3.3V (V)

Displays the voltage across the analog part of the
receiver board.

Digital part 5V (V)

Displays the voltage across the digital part of the
receiver board.

Analog part 5V (V)

Displays the voltage across the analog part of the
receiver board.

Temperature (°C)

Displays the temperature of the receiver board.
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Table 2-8. Connected Receiver Details (Continued)

Field

Description

Flash memory size

Displays the amount of available memory in your
receiver for raw data storage.

Flash memory free

Displays how much receiver memory is free.

Number of files

Shows the number of raw data files in the receiver mem-
ory.

Bad blocks

Displays the number of bad blocks (if any) in the
receiver memory.

Write verify

Displays the state of the write verify feature.

Block size

Displays the block size of the receiver’s memory.

Blocks for files

Displays the total amount of the receiver’s physical
memory in blocks.

Physical memory

Displays the total amount of the receiver’s physical
memory in bytes.

Current port

Shows the port the receiver is currently communicating
through with PCView.

Speed

Shows the baud rate at which the receiver communicates
with the PC.

Parity

Shows whether parity checking is used or not. If used,
displays the form of parity checking.

Stop bits

Shows the number of bits used to mark the end of a byte.

RTS/CTS

Shows whether hardware handshaking is used or not.

Infrared

Shows the status of the infrared port.

Time from last reset

Shows time elapsed since the last receiver reset.

Hardware version

Shows JNS’s specific information.

Boot loader version

Shows JNS’s specific information.

Wait states

Shows the flash memory access time expressed in wait
states.

Along with the information about the connected receiver, this window contains

four buttons that have the following functions:
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Save to file — Records your receiver’s configuration information to a text file
on the computer drive. For details on how to save this vital receiver
information and submit it to JNS.

Report — Records the contents of the About PCView window together with
the status of receiver options to a text file on the computer drive.

Refresh — Updates the receiver details list.
OK - Closes the window.
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This chapter provides information on how to identify and remedy minor
software problems.

Things to Check First

Before contacting JNS Customer support about any problems with the PCView
software, refer to the following list of basic suggestions that may help:

www.javad.com

Go through all external receiver connections carefully and make sure they are
not wrong or loose.

Double-check the cables. Cables became defective more often than the
devices do.

Check the sections below for available solutions.
Reset the receiver using PCView (Tools->Reset receiver).

Restore factory default settings using PCView (click Configuration-
>Receiver, then Set all parameters to defaults).

Clear the NVRAM (see “Clear NVRAM” on page 2-77).

Initialize the file system using PCView (click Tools->Initialize file system;
this will erase all files inside the receiver).
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Error Messages

The following are the error messages you may encounter while working with

PCView.

Table 3-1. Error Messages

Message

Possible Cause

Corrective Action

Can't find receiver

The receiver is turned off.

Apply power and turn the
receiver on.

The wrong computer port
specified.

Select the correct com-
puter port.

The receiver port you are
trying to connect to is not in
the command mode.

Use another free receiver
port to connect with a
computer.

Can't connect to the
server

PCView Internet Server is
not started.

Configure and run
PCView in Internet Server
mode. For details, refer to
“Internet Server Mode” on
page 1-19.

PCView Internet Server is
not properly configured.

Double-check the Internet
Server configuration. For
details, refer to “Internet
Server Mode” on

page 1-19.

PCView Internet Client is
not properly configured.

Double-check the Internet
Client configuration. For
details, refer to “Internet
Client Mode” on

page 1-21.

*Can't set <parameter>
*Can't set <value> for
<parameter>
eIncorrect <parameter>
value

eInvalid <parameter>
eInvalid value for
<parameter>

PCView and the receiver are
disconnected.

Check the cable connec-
tion between the receiver
and computer and restore
the connection. For
details, see “Getting Con-
nected” on page 1-6.

The parameter value is out
of acceptable range.

Specify the value within
the range of the selected
parameter.
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Table 3-1. Error Messages

Message

Possible Cause

Corrective Action

Converter application
file not found!

PCView cannot locate the
Jps2rin_exe file in the
specified path.

Make sure you have this
file on the computer and
double-check the file loca-
tion.

Modem not found

The wrong receiver port.

Select the correct receiver
port. For details, see
“RFM96 Configuration
Window” on page 2-70.

There is no radio modem
installed in your receiver.

Open COMXx port failed:

Access is denied
(where x — 1, 2, 3, 4,...)

Another application uses the
computer port dedicated for
connection

Close the application, then
re-connect.

Alternatively, connect the
receiver via another,
unused computer port.

Unable to create file

The receiver has no free
space for files.

Download receiver files to
acomputer and then delete
unnecessary files from the
receiver.

The receiver has no memory.

Contact your dealer to
equip the receiver with
memory.

The receiver has already
logged 512 files into the
internal memory.

Delete unnecessary files.

File name contains not
allowed characters

Characters cannot be used in
the name of the log file.

Rename the log file using
only allowed characters.
The following characters
cannot be used in the
name of the log file: space,
comma, {},(), @, &,",/\
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Obtaining Technical Support

If the troubleshooting hints and tips in this User’s Manual fail to remedy the
problem, contact JNS Support.

Table 3-2. Technical Support E-mail

For Questions Related To... Use...
PCView pcview @javad.com
Hardware (receivers, antennas, firmware) hardware @javad.com

If in doubt about which e-mail address to use for your particular question,
please send it to support@javad.com.

Tip:  To provide you with quick and effective support,
provide us with detailed description of the problem.

Typical steps you should take to provide us with this information are as
follows:

4. Reveal the exact conditions when the problem occurs.
* What receiver model and configuration settings do you use?

—The easiest way to provide this information is to use the Save to file
button in the About PCView window. To do this, run PCView and
establish a connection between the receiver and the computer. Click
Help, then click About, or alternatively press Ctrl+U. Click Save to
file. Specify a name of the text file and click Save. The file will be saved
onto the selected computer’s drive.

* What system/hardware specifications does the computer on which you
are running (installing) PCView have?

* What symptoms and/or error codes/messages do you see?
* Does the problem happen regularly or occasionally?
5. Document the problem and create support request package.

* Write an e-mail that contains complete explanation of the problem with
answers to the questions from Step 1.

* Attach the file created in Step 1 to this e-mail.
6. Submit e-mail to Customer Support.

* Send the e-mail you wrote in Step 2 to an appropriate electronic address
given in “Obtaining Technical Support” on page 3-4.
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Notice: Generally, you will receive a response within 24 hours or less,
depending on the severity of the problem.

Tip:  You can also check our online resources for the
latest product support information.

Web Site

The JNS Positioning Systems website provides current information about
JNS’s line of products. The support area of the website provides access to
frequently asked questions, configuration procedures, manuals, e-mail
support, etc.

To access the NS website home page, use: www.javad.com

www.javad.com PCView Software Manual ~ 3-5



Notes:

3-6 PCView Software Manual www.javad.com



PGVIEW Scriets

This appendix will help you write PCView scripts. It describes:
* the script language components, including variables and commands.

* the syntax of the commands, their function and usage.
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Introduction to Scripting

Script is a plain text file each line of which is either a receiver command, or a
PCView command, or a comment. Scripts allow you to save a set of manual
commands into one file. You can then load this single script instead of typing
each individual command.
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Variables

Variables are special character sequences that allow you to store some specific
values' in scripts. They can then be used in place of the values they store while
running the script.

Currently PCView supports the following variables:
@1, @2, @3, @4, @5, @6, @7, @8, @9, and @0

The first nine of these variables initially contain the values of the script's
command line arguments.

With the command @default, you can assign the default values to these
variables unless the corresponding arguments have already been specified
through the script command line. Also, you may use the @set command to
change the variables' values.

The variable @0, which is read-only, has a special purpose. Initially it contains
the script name specified in the command line. In the course of script execution,
it will either contain the last of the receiver's positive acknowledgements (i.e.,
the most recent of the REXXX replies), or remain empty.

After getting REXXX from the receiver, PCView will search the received
sequence for the last of the «%» symbols it contains. PCView does not assign to
the variable @0 the entire RExxx reply, but only the characters following
immediately after the last «%» symbol (until the end of this sequence is found).
Leading and trailing spaces are trimmed. With the @set command, you can
assign the value of @0 to other variables.

1. Specified by the user and stored by PCView.
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PCView Commands

In essence, a PCView command is a single word that instructs the receiver what
to do.

Any line starting with the «@» character is interpreted as a PCView command
with optional arguments separated by commas or spaces. In Table A-1 you will
find the description of supported commands.

Table A-1. List of PCView Commands

Command Arguments Description
:<label Specifies a label to which you want the
name> PCView’s command interpreter to jump.

Label names should not contain spaces
or commas. See the goto command for
how to use labels.

call <script name> [<arguments>] | Executes another script from within the
current script.

The maximum number of recursive calls
is 200.

clear Removes issued commands and receiver
replies from the Manual Mode window.

default <variable> <default value> Defines the default values for those of
the script arguments that were not
explicitly specified in the command line.
For example,

@default @1 a

assigns the value a to the variable @1
unless this argument is already defined
in the command line.

disconnect Stops script execution, disconnects
PCView from the receiver and closes the
Manual Mode window. This is the same
as pressing the Disconnect button.

echo on Turns echo on and off, or displays its
off arguments. If echo is turned on, PCView
any character sequence will display all nonempty lines entered

in the script, specifically, PCView com-
mands, receiver commands and the cor-
responding reply messages. If echo is
turned off, PCView will display only
replay messages preceding them with the
«>» character.

PCView will not show @echo off and
@echo on commands.

Default is «on».
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Table A-1. List of PCView Commands

Command Arguments Description

exit Stops script execution, disconnects
PCView from the receiver and exists
PCView.

goto <label name> Jumps to the line following immediately
after @:<label

name>.

If PCView cannot find such a label in the
script, this command is just ignored and
PCView continues with the script.

send <bytes to send> Sends the argument to the receiver as is,
without making any substitutions. This
string may contain escape sequences in a
C-like style to represent non-printable

characters.

Sequence | Value | Character

\a 0x07 |BEL

\b 0x08 |BS

\f 0x0C |FF

\n 0x0A |LF

\r 0x0D |CR

\t 0x09 |HT

\v 0x0B | VT

\ 0x5C | Backslash

\" 0x22 | Double quote

\O any O —octal character
code

\xH any H - hexadecimal
character code

Example:
@send "#OFF#\r\n"
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Table A-1. List of PCView Commands

Command Arguments Description

set * rate <new baud rate> With these commands, you can assign

« rtscts [on,off] both serial ports' parameters and

* <variable> <value> PCView's internal variables.

Example 1:

Suppose you have a script with the com-
mands

@set @1 "a text"
@echo @1

When the script interpreter reaches the
echo command, you will get the follow-
ing reply:

>a text

Example 2:

Assign the current terminal's baud rate to
@2:

9% %oprint,/pat/cur/term/rate

@set @2 @0

sleep integer number of milliseconds | PCView interrupts script execution for a
specified number of milliseconds.

stop Stops script execution.

stoponerrors | on Enables/disables PCView' stop-on-error
off option. This indicates whether PCView
will stop script execution after getting an
ERxxx message from the receiver.
Default is «on».

timeout integer value in milliseconds, | If a receiver command starts with a «%»
default is 5000 symbol, PCView will wait for the
receiver to reply within the specified
timeout interval. If a reply is received
during this time, it will be saved to the
variable @0. If no reply is received over
the timeout interval, or if after receiving
a few bytes PCView gets no more data
for 100+ milliseconds, or if PCView
keeps receiving continuous data for
more than 100 milliseconds, @0 will be
undefined (however, script execution
will continue). In this you may need to
adjust the timeout interval to be sure that
the variable @0 contains correct infor-
mation.
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Receiver Commands
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Using scripts the user can specify receiver commands’ arguments either
explicitly or through variables.

When you use variables for this purpose, these will be substituted by PCView
for some specific values before sending the corresponding command to the
receiver. If the user sends a receiver command that starts with «%» (command
label), PCView will wait for the receiver to reply and, if a reply is received, it
will save the reply to the variable @Q.

Currently the character «@» is used in GRIL commands only to delimit the
command checksum. It should not cause any problems since PCView
automatically adds a checksum for every command sent to the receiver.

PCView does not interpret receiver commands. Therefore, if one uses receiver
commands that change the baud rate and/or handshaking for the current receiver
port (that is the port to which PCView is connected), you should either use
appropriate @set commands immediately after them, as shown below:

%%set,/par/cur/term/rtscts,off
@set rtscts,off
%%set,/par/cur/term/rate, 9600
@set rate,9600

or specify such receiver commands at the end of the script, immediately before
@disconnect or @exit. Otherwise, PCView may be locked up waiting for the
receiver to reply.

Below will be found some examples illustrating various applications of scripts.
@default @1,c

% %set,dev/ser/ @ 1/imode,rtcm

% %set,dev/ser/ @ 1/rate, 9600

% %oset,/par/pos/mode/cur,cd

% %em,,/msg/nmea/GGA:1

@exit

After these lines are saved to a file (e.g., beacon. jpc), you can then type in
the command line @beacon and press Enter to instruct the receiver to input
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RTCM corrections from serial port C and output NMEA messages to the current
terminal. If the user wants to use serial port B for inputting corrections, type
@beacon b and press Enter.

The following example illustrates how the goto command and labels are used
in scripts intended for work with different receiver models.

Yo/par/rcv/model%oprint,/par/rcv/model
@goto [s@0

@echo Unknown receiver model.
@stop

@:IsPrego

@echo Receiver is Prego!

@goto end

@:IsLexon

@echo Receiver is Lexon!
@goto end

@:IsEurocard

@echo Receiver is Eurocard!
@:IsMAXOR

@echo Receiver is MAXOR!
@goto end

@:end

@stop
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Writing and Editing Scripts

www.javad.com

You can create and edit scripts directly in the PCView’s Manual Mode window
or in any text editor, e.g. Notepad.

To create a script using the Manual Mode window:

1. In the Manual Mode window, click the Edit script button.

2. Enter the name of a new script in the File name field.

3. Click the Open button.

4. Type the script commands.

5. Click the Save script button.

To edit an existing script using the Manual Mode window:

1. In the Manual Mode window, click the Edit script button.

1. Navigate to a list of available scripts and select the desired script name from
that list.

. Click the Open button.
. Make necessary changes in the script and then click the Save script button.
Finally, click the Close editor button.

For easy access to scripts, keep them all in one directory,
e.g. in PCView’s working directory.

ENANN
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Running Scripts

To run a script through the command line of the Manual Mode window:

1.

Notice:

Enter the script name with a preceding '@’ character (e.g. @my_script).
OR

Click the Load script button and select the required script from the Script
file window.

. Specify script arguments, if required.

Click the Send command button.

Script arguments should be delimited by either spaces or
commas. If some of the arguments in the command line contain
separators (spaces and/or commas), put such arguments into
double quotes, e.g.. @myscript “This is one argument”.

After PCView starts script execution, it will read the file line by line carrying
out the following operations, if necessary:

To

skipping empty and comment lines;

replacing variables with their specific values;

echoing non-empty lines to the screen (if echo is enabled);

interpreting PCView internal commands, and;

sending commands to the receiver and (optionally) waiting for receiver
replies.

abort script execution, click the Stop script button.

Running Scripts from Windows Explorer

Files with the extension .tpc are automatically associated with PCView. It
means that you can launch PCView (specifically in Manual mode) by
clicking on a script in the file/directory tree. It can be achieved with the use
of Windows Explorer, My Computer or some other Windows file manager.

After the Connection Parameters window pops up, you click the Connect
button to open PCView’s Manual Mode window. Note, however, that the
script you selected will not start automatically so that you should type the
name of desired script in the command line or select the script through th
Load script button. After existing manual mode, you can continue working
with PCView in the usual way.
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OuTPUT PERIOD SETUP
WizaARD

The Output Period Setup Wizard is a feature that helps you select and set the
correct values for generating raw data and updating the receiver position.

PCView will open this Wizard only if you try to specify an incorrect recording
interval. Once the Wizard is run, follow the on-screen instructions to adjust the
typed values.

The following five figures, which are given here just for your convenience,
show how the Output Period Setup Wizard windows look. These windows are
listed in order of appearance.

utput Period Setup Wizard

‘waming | The requested value of Dutput Period [Recording Inteval] is
not supported by your receiver due to the imitations impoged by the
1eceivers curent settings.

Press "Cancel” to force Output Pericd to be the requested value
anyuay.

Press "Mext" if vou want to adjust the requested walue of Output Period
s Lhal it Do curnsistenl wilh the ieceive'’s cunenl sellings,

et x> !

Figure B-1. Wizard’s 1st Window
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2 Output Period Setup Wizard

Figure B-2. Wizard’s 2nd Window

# Qutput Penod Setup Wizard

Figure B-3. Wizard’s 3rd Window
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Output Period 5 etup Wizard

Figure B-4. Wizard’s 4th Window

Dutput Period Setup Wizard

Figure B-5. Wizard’s 5th Window
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SATELLITE NAVIGATION
STATUS GODES

Table C-1 lists the codes as seen in the SS column on the Main window in the

PCView software.

Table C-1. Satellite Navigation Status Structure

Code Description

00 C/A data used for position computation

01 P1 data used for position computation

02 P2 data used for position computation

03 Ionosphere-free combination used for position computation

04 Measurements unavailable

05 Ephemeris unavailable

06 Unhealthy SV (as follows from operational (=ephemeris) SV health)

07 Time-Frequency parameters from the ephemeris data set may be wrong1

08 Initial conditions (position and velocity vectors) from the ephemeris data set
may be wrong®

09 Almanac SV health indicator unavailable for this satellite®

10 Unhealthy SV [as follows from the almanac SV health indicator]*

11 “Alert” flag (from the word “HOW”) is set?

12 URA indicates the absence of accuracy prediction for this Svb

13 User excluded this SV from position computation

14 User excluded this SV with this frequency channel number from position
computation®

15 This SV is excluded from solution since its system number is unknown®

16 This SV has an elevation lower than the specified mask angle

PCView Software Manual
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Table C-1. Satellite Navigation Status Structure (Continued)

Code Description
17 Reserved
18 Ephemeris data is too old
19 This SV does not belong to the constellation the user has selected
20 Differential data from Base Station unavailable for given satellite
(applicable only when receiver runs in DGPS)
21 Reserved
22 RAIM has detected wrong measurements
23 SNR below specified minimum level
24,25 | Reserved
26 DLL not settled
27 Ionospheric corrections are not received from Base Station
28 Coarse code outlier has been detected
29 Reserved
30 SV is not used in RTK processing (similar to code 20 but is used specifically
for RTK)
31 The same as 30
32-50 | Reserved
51 C/A slot used in RTK processing
52 P L1 slot used in RTK processing
53 P L2 slot used in RTK processing
54 P L1 & P L2 measurements used in RTK processing
55 C/A & P L2 measurements used in RTK processing
56-62 | Reserved
63 Satellite navigation status is undefined

1. GLONASS only
2. GPS only

Notice: Codes 0-3 and 45-62 will show for the given satellite which raw
data measurements have been used in position computation.
The rest codes will indicate why this satellite has been excluded
from position computation.
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